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Jak získat Slic3r 

Stažení 

Slic3r je možné stáhnout přímo z adresy: http://slic3r.org/download. 

Jsou zde k dispozici předkompilované balíčky pro operační systémy Windows, Mac OS X 

and Linux. Uživatelé používající o.s. Windows nebo Linux si mohou vybrat mezi 32 a 64 

bitovou verzí. 

Zdrojový kód 

Celý zdrojový kód je k dispozici skrze GitHub: https://github.com/alexrj/Slic3r. Více se 

dozvíte v kapitole „Sestavení ze zdrojového kódu“. 

Instalace 

Windows 

Rozbalte stažený soubor s příponou zip do jakékoliv složky, kterou si vyberete. Slic3r nemá 

instalační soubor, a není nutné jej instalovat. Ve složce, kam jste stažený zip soubor rozbalili, 

naleznete dva spustitelné soubory: 

 slic3r.exe – spustí standardní grafické uživatelské rozhraní. 

 slic3r-console.exe – se používá pro práci v příkazové řádce. 

Stažený zip soubor můžete nyní smazat. 

Mac OS X 

Dvojklikem otevřete stažený dmg soubor, spustí se Finder a vněm bude ikona Slic3ru. 

Přejděte do adresáře Application a přetáhněte do něho ikonu Slic3ru. Nyní můžete smazat 

stažený dmg soubor. 

Linux 

Rozbalte stažený archiv do složky podle vlastního výběru. Pak buď: 

• Spusťte Slic3r tak, že spustíte přímo spustitelní soubor „Slic3r“, který se nachází v 

adresáři bin, nebo  

• Nainstalujte Slic3r spuštěním spustitelného souboru „do-install“, který je také ve 

složce bin. 

Soubor se staženým archivem pak můžete odstranit. 

http://slic3r.org/download
https://github.com/alexrj/Slic3r
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Sestavení ze zdrojového kódu 

Ti, kteří chtějí využít poslední dostupnou verzi Slic3ru, si jej mohou sestavit sami přímo ze 

stále se vyvíjejících zdrojových kódů uložených na GitHub. 

Aktuální informace a instrukce, jak zkompilovat a zpustit Slic3r ze zdrojového kódu, jsou 

dostupné na Slic3r Wiki. 

 GNU Linux 

https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-GNU-Linux 

 OS X 

https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-OS-X 

 Windows 

https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-Windows 

https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-GNU-Linux
https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-OS-X
https://github.com/alexrj/Slic3r/wiki/Running-Slic3r-from-git-on-Windows
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První tisk 

Kalibrace  

Ještě předtím, než se pokusíte o první tisk, je důležité tiskárnu správně zkalibrovat. 

Přeskočení tohoto kroku, nebo zanedbání kalibrace povede jen frustraci, že se pozdější tisk 

nedaří. Takže je důležité, investovat čas nejprve ke správnému nastavení všech součástí 

tiskárny.  

Každá tiskárna je jiná a může mít svůj vlastní individuální postup kalibrace. Tato příručka se 

nepokouší pokrýt všechny variace. Provede vás pouze klíčovými body, které je nutné vždy 

projít.  

 Rám je stabilní a správně srovnán.  

 Pásy posuvu jsou napnuté.  

 podložka je v rovině vůči dráze extrudéru.  

 Vlákno se volně odvíjí z cívky, aniž by docházelo k zatížení extrudéru.  

 Proud pro krokové motory je na driverech nastaven na správnou úroveň.  

 Firmware je správně nastaven, včetně: rychlosti pohybu os a zrychlení, regulace 

teploty; všech end stopů; směru otáčení motorů.  

 Extrudér je kalibrován ve firmwaru se správnými kroky na mm vlákna.  

Bod týkající se nastavení kroků extruderu je velmi důležitý. Slic3r očekává, že tiskárna bude 

naprosto přesně produkovat stanovenou délku vláknu. Příliš vlákna bude mít za následek 

kaňky a jiné nedokonalosti v tisku. Příliš málo vlákna bude mít za následek mezery a špatné 

přilnutí vrstev mezi sebou.  

Další informace naleznete v dokumentaci k tiskárně a další podrobnosti o tom, jak nejlépe 

kalibrovat konkrétní stroj se dozvíte také ze zdrojů okolo 3D tiskové komunity.  

Průvodce konfigurací Slic3ru 

Slic3r má dva nástroje, které pomáhají nováčkům v 3D tisku. Průvodce konfigurací a Simple 

režim pro nastavení. 

Někdy je dobré mít v začátcích s novým softwaerem pomocnou ruku. Průvodce konfigurací 

vám položí řadu otázek a dle vašich odpovědí sestaví základní konfiguraci Slic3ru. 
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Obrázek 1 - uvítací obrazovka průvodce konfigurací 

 

Typ Firmware 

G-kód produkovaný Slic3rem je navržen pro jednotlivé typy firmware. První krok průvodce 

vás vyzve výběru firmwaru, který tiskárna používá. Typ firmware by mělo být uveden na 

uvítací obrazovce displeje tiskárny nebo v její konfiguraci. Pokud si nejste typem jisti, 

kontaktujte dodavatele. 

Obrázek 2 - obrazovka výběru typu firmware 

 

Rozměr tiskové podložky 

Toto nastavení definuje maximální vzdálenost pohybu extruderu na osách X a Y. Pokud tyto 

rozměry neznáte, může je snadno změřit. 

Ujistěte se, že měříte od levého dolního rohu (startovní pozice trysky, kdy extruder stojí na 

end stop osy X a podložka na end stop osy Y) do pravého zadního rohu (tryska je 

v maximálních pozicích os X a Y). Změřte vzdálenost v těchto dvou směrech a zadejte je do 

průvodce. Vezměte v úvahu, že X vozík může narazit do rámu ještě před tím, než tryska 

dosáhne plné vzdálenosti, závisí na značce a modelu vaší tiskárny. 
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Také nezapomeňte zkontrolovat nastavení end stop ve firmwaru, protože ty také mohou 

omezit pohyb po osách X a Y 

Obrázek 3 - obrazovka konfigurace rozměrů tiskové podložky 

 

Průměr trysky 

Průměr hot-end trysky je obvykle zřetelně zobrazen buď v popisu hot-endu, nebo v příslušné 

dokumentaci, je-li hot-end dokoupen. Obvyklé průměry jsou 0,5 mm a 0,35 mm. 

Pokud je tryska domácí výroby, nebo pochází ze zdroje, který průměr neuvádí, můžete 

opatrně průměr otvoru trysky změřit posuvkou, co nejpřesněji to půjde.  

Jeden ze způsobů, jak určit průměr trysky je, velmi pomalu (1 mm / s), vytlačit vlákno do 

volného prostoru a změřit jeho průměr. To má tu výhodu, že změříte průměr skutečně 

vytlačovaného vlákna, včetně průměru o který nabobtná, což může být dobré i v případě, že 

průměr trysky znáte. 

Obrázek 4 - nastavení průměru trysky 
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Průměr filamentu 

K tisku přesných modelů je pro Slic3r nutné co nejpřesněji znát kolik materiálu se posunuje 

do extruderu. Proto je velmi důležité, co nejpřesněji změřit průměr filamentu. 

Ačkoliv se filament používaný v tiskárnách FDM prodává v průměrech 3 mm nebo 1.75mm, 

jedná je tento rozměr pouze orientační. Průměr se může lišit od výrobce k výrobci a dokonce i 

mezi v rámci jednoho výrobce a stejné série, někdy i stejné role. Proto se doporučuje provézt 

vlastní měření na více bodech stejného filamentu a výsledek zprůměrovat. Například, 

měřením získáme hodnoty 2,89, 2,88, 2,90 a 2,91 tedy průměr použijeme 2.895. 

Obrázek 5 - okno průvodce pro nastavení průměru filamentu 

 

Teplota hot-endu 

Teplota extruze závisí na použitém materiálu filamentu, přičemž většina z nich může pracovat 

v určitém rozsahu teplot. Informace o vhodných pracovních by vám měl poskytnout dodavatel 

filamentu. Velmi obecné pravidlo je, že ideální pracovní teplota PLA leží mezi 160 ° C a 230 

° C a pracovní teplota u ABS leží mezi 215° C až 250° C. Další specifické materiály mají jiný 

rozsah. 

Tento parametr budete později dolaďovat, ideální teplota se mění i v rámci jednotlivých 

barevných variant stejných materiálů od stejného výrobce. Dalším faktorem, který ovlivňuje 

správnou teplotu, je rychlost vytlačování, kde obecně platí: rychlejší vytlačování požaduje 

vyšší teplotu teplejší. 

Poznámka: Pokud budete teplotu hot-endu regulovat ručně, pak může být teplota zde 

nastavena na nulu. 
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Obrázek 6 - nastavení teploty hot-endu 

 

Teplota podložky 

V případě, že má tiskárna vyhřívanou podložku, pak zde můžete její teplotu nastavit. Stejně 

jako v případě teploty hot-endu, i tato hodnota závisí na použitém materiálu. Pravidlem je, že 

PLA vyžaduje teplotu podložky okolo 60 ° C a ABS okolo 110 ° C. 

Poznámka: Je možné zvolit manuální ovládání teploty podložky přímo na tiskárně. V tomto 

případě může být zde teplota nastavena na nulu. 

Obrázek 7 - nastavení teploty vyhřívané tiskové podložky 

 

Nyní máte hotovou základní konfiguraci Slic3ru. 
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Obrázek 8 - dokončení konfigurace průvodcem 

 

Důležitá první vrstva 

Předtím, než se pustíte do prvního tisku, stojí za to dozvědět se něco o důležitosti správného 

tisku první vrstvy. Jak mnozí zjistily metodou pokusu a omylu, není li první vrstva vytištěna 

správně, může to vést k odlepení od podložky, deformaci výtisku a celkovému selhání tisku. 

Existuje několik technik a doporučení, kterých se můžete řídit, aby se minimalizovala 

pravděpodobnost takového selhání. 

Vyrovnání podložky 

Vyrovnání podložky a její vzdálenost od trysky je velmi důležitá. Pokud je vzdálenost trysky 

od podložky příliš malá, filament nemusí jít vůbec vytlačit, případně může dojít dokonce 

k poškrábání skla na podložce. Pokud je vzdálenost trysky od podložky naopak příliš velká, 

materiál k ní nepřilne a během tisku se odloupne. 

Vyšší teplota 

Hot-end a podložka, pokud je vyhřívaná, může být ohřáta pro první vrstvu na vyšší teplotu. 

To zvýší viskozitu materiálu a ten k podložce lépe přilne. Jako pravidlo se doporučuje nastavit 

pro první vrstvu vyšší teplotu cca o 5°C. 

Nižší rychlost 

Zpomalení tiskové hlavy pro první vrstvu sníží síly působící na taveninu, čímž se snižuje 

pravděpodobnost, že se vlákno natáhne příliš a nebude držet na podložce. Doporučuje se 

zpomalení na 30% nebo 50% běžné rychlosti. 

Správné nastavení množství materiálu 

Pokud je vytlačováno příliš mnoho materiálu, tryska skrze něj projíždí při dalším průchodu, 

což způsobuje jeho uvolnění od podložky, především když materiál mezi tím vychladne. Příliš 

málo materiálu vede k nedokonalému přilnutí a mezerám mezi vlákny, později může dojít 

opět k odtržení od podložky a deformacím výtisku. Z těchto důvodů je důležité, aby byl 
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správně nastaven průměr filamentu, průměr trysky a kroky extruderu, tak jak je popsáno 

v sekci Kalibrace. 

Výška první vrstvy 

Větší výška první vrstvy způsobí větší průtok materiálu a následně tedy více tepla, čímž dojde 

k lepšímu přilnutí materiálu k podložce. Další výhodou je, že větší výška první vrstvy 

poskytuje větší toleranci pro vyrovnání podložky vůči trysce.  

Výšku první vrstvy se doporučuje nastavit tak, aby, aby odpovídala průměru trysky. Např. 

první výška vrstvy 0,35 mm pro trysku o průměru 0,35 mm. 

Poznámka: Takto se nastaví výška první vrstvy automaticky v Simple režimu. 

Tlustší šířka vytlačovaného materiálu 

Čím více materiálu se dotýká podložky, tím lépe se k ní objekt přilepí. Toho lze dosáhnout 

zvětšením šířky vytlačování první vrstvy, a to buď v procentech, nebo pevnou šířkou. 

Případné mezery mezi jednotlivými vlákny jsou odpovídajícím způsobem změněny. 

Obvykle se doporučuje hodnota okolo 200%, ale je potřeba dodat, že tato hodnota šíře 

vytlačování se vypočte z výšky vrstvy, takže by měla být nastavena pouze v případě, že výška 

vrstvy je nastavena na nejvyšší možnou (průměr trysky). Například: v případě, že výška 

vrstvy je 0,1 mm, a šířka vytlačování je nastavena na 200%, pak skutečná šířka extrudované 

bude pouze 0,2 mm, což je méně než průměr trysky. To by způsobilo špatný průtok materiálu 

tryskou a vedlo by k selhání tisku. Proto je velmi vhodné kombinovat vysokou výšku první 

vrstvy s doporučením uvedeným výše.  

Nastavení výšky první vrstvy na 0,35 mm a šířky vytlačování první vrstvy na 200% by mělo 

vézt k pěknému širokému vláknu o šíři 0,65mm. 

Materiál podložky. 

Podložky se vyrábějí z mnoha různých materiálů, volba správného materiálu podložky a 

příprava jejího povrchu může výrazně zvýšit přilnavost tisku k podložce. 

PLA je velmi shovívavý materiál a výborně drží například na PET, na Kaptonové nebo modré 

malířské pásce. 

ABS obvykle potřebuje trochu více přemlouvání a I když jej lze tisknout na PET i 

Kaptonovou pásku, je vyzkoušené, že velice dobře drží například na tenké vrstvě laku na 

vlasy nebo na ABS juice (trocha ABS plastu rozpuštěného v acetonu a nastříkaného na 

podložku rozprašovačem)  

Nechladit 

Přímo souvisí s výše uvedeným, nemá smysl, zvyšovat teplotu první vrstvy a mít zapnuté 

ofukování modelu ventilátorem nebo jiným chladícím mechanismem. Doporučuje se tedy, při 

tisku první vrstvy vypnout chlazení.  
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Práce s modely  

Než budete moci začít s prvním tiskem, musíte si ještě připravit váš tiskový model a rozdělit 

jej na jednotlivé vrstvy. 

Formátu modelů  

Slic3r akceptuje následující typy souborů.  

 STereoLithography (STL) soubory, které mohou pocházet z různých zdrojů a jsou 

nyní, de facto, standardem v 3D tisku. Soubory jednoduše popisují povrchovou 

geometrii 3D objektu, bez jakýchkoliv dalších informací o modelu (jako například 

barvy nebo druhu materiálu). Jednoduchost tohoto formátu jej předurčuje k velkému 

rozšíření a popularitě.  

 Wavefront OBJ soubory, jsou otevřeným formátem původně použitým v aplikacích 

pro tvorbu animací od Wavefront Technologies. Ale po té byl tento formát převzat 

širší komunitou, zabývající se 3D modelováním. Formát je podobný formátu STL.  

 Additive Manufacturing File Format (AMF), byl vyvinut jako reakce na omezení ve 

formátu STL. Kromě popisu geometrie 3D modelu, je zde možné také popsat barvy a 

materiály, a další složitější atributy, například přechody materiálů a jejich mísení a 

další uspořádání objektů a jejich závislosti. Tento formát je považováno za normu, ale 

ještě musí být široce přijat v 3D komunitě.  

Jak získat modely  

Model pro 3D tisk lze získat z různých online uložišť jako Thingiverse nebo GrabCAD, ale 

můžete si je i sami vytvořit pomocí různých CAD aplikací.(například FreeCAD, SketchUp, 

nebo OpenSCAD) případně pomocí webových aplikací jako je Shapesmith. 

Pokud budete chtít zobrazit modely ještě před rozdělením do vrstev, můžete použit nějakou z 

mnoha volně dostupných aplikací. Jednou z nich je třeba Meshlab, což je komplexní nástroj 

určený pro prohlížení a práci s 3D soubory. (poznámka – nová verze Slic3ru již prohlížení 

modelu ve 3D také umožňuje přímo v okně Plater) 
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Obrázek 9 - on-line CAD nástroj Shapesmith 

 

Práce s Plater  

Slic3r disponuje nástrojem, tzv Plater, který umožňuje jeden nebo více modelů načíst a 

uspořádat je na tiskovou podložku ještě před tím než budou rozděleny na jednotlivé vrstvy.  

Obrázek 10 - nástroj Plater ve Slic3ru 

 

Poté, co získáte model, můžete jej přetáhnout do okna Plater (případně použijte tlačítko Add) 

čímž dojde k načtení modelu do Slic3ru. Na obrázku níže, je načten v Plateru tradiční RepRap 

model Minimug, v Plateru ji zobrazen z pohledu shora. Kruh kolem modelu je Skirt 

ohraničení což je jednoduchý prstenec, vzdálený několik milimetrů od modelu, který se tiskne 

jako první a slouží k dobrému zavedení materiálu do trysky.  
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Obrázek 11 - RepRap model Minimug 

 

Obrázek 12 - načtený STL model ve Slic3ru 

 

Načtené modely lze na podložce různě přemísťovat, nicméně Slic3r se vždy snaží modely 

soustředit kolem definovaného středového. Rozměry podložky by měly odpovídat rozměrům 

podložky v tiskárně, tak jak jste je nastavovali v průvodci konfigurací výše.  

Na pravé straně je k dispozici seznam aktuálně načtených souborů. Tlačítka podél horní části 

seznamu souborů vám umožní měnit uspořádat modelů. (poznámka: v nové verzi jsou tlačítka 

nad náhledem modelů)  

 + / - - Přidá a ubírá počet kopií modelu.  

 45 ° / Rotate - Otočení vybraného modelu okolo osy Z, v krocích po 45 ° buď po 

směru, nebo proti směru hodinových ručiček.  

 Scale – Umožní zvětšení nebo zmenšení modelu.  

 Split - Rozdělí model, který se skládá z více než jedné části do jednotlivých součástí, 

tak, aby se s každou z nich dalo manipulovat samostatně.  
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Další tlačítka umožňují přidávat, odebírat, automaticky uspořádat, nebo exportovat načtené 

modely.  

 Add - Otevře dialogové okno souboru pro přidání modelu do Plater, slouží jako 

alternativa k přímému přetažení souboru.  

 Smazat / Delete All - Odstraní jeden nebo všechny modely z Plater.  

 Autoarrange – Pokusí se uspořádat všechny načtené modely a najít tak jejich 

optimální rozložení na tiskové podložce.  

 Export G-code - Spustí rozřezání modelů na vrstvy a vytvoří soubor s G-kódem.  

 Export STL - Uloží aktuální sadu modelů jako jediný model do souboru STL.  

Opravy modelů 

Pokud model obsahuje chyby v 3D návrhu, například chybí stěny, nebo jsou stěny 

nevyrovnané, pak se Slic3r pokusí tyto chyby opravit sám. Nicméně některé chyby mohou být 

mimo rozsah jeho možností. V případě, že si aplikace stěžuje, že model nemůže být rozdělen 

do vrstev správně, pak existuje několik možností jak model dále upravit – viz kapitola 

„Opravy modelů“.  
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Tisk 

V této fázi máte nakonfigurovaný Slic3r, zkalibrovanou tiskárnu a rozvrstvený model 

připravený k vytištění. Tedy je čas zahřát tiskárnu a otestovat tisk. 

Potřebujete jen nějaký software, který umožní odeslat G-kód do tiskárny. K dispozici jsou 

různé programy, které s 3D tiskárnou komunikují, mezi nejpoužívanější Open-source řešení 

patří: Printrun, Repetier a Repsnapper. 

V následujících částech návodu se budeme zabývat různými možnostmi nastavení, které jsou 

ve Slic3ru dostupné, a podíváme se na některé pokročilejší tiskové techniky včetně některých 

speciálních případů a řešení případných problémů. 
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Simple režim 

Slic3r má dva režimy nastavení, Simple a Expert. Ty je možné mezi sebou měnit v záložce: 

File->Preferences. 

Obrázek 13 - okno Preferences 

 

Simple režim nabízí omezené množství položek pro nastavení tisku, nicméně pro začátečníka 

by tento režim měl být dostačující. Expert režim pak poskytuje možnost daleko lépe 

kontrolovat výstupní G code produkovaný Slic3rem. 

Print Settings - nastavení tisku 

Karta Print Settings poskytuje nastavení související s aktuálním tiskem. Zatímco ostatní 

karty se mění jen minimálně, nastavení na této kartě budete měnit téměř s každým tištěným 

modelem. 

Obrázek 14 - režim Simple: nastavení tisku. 
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General 

Layer height je tloušťka každé vrstvy, tedy posun vertikální osy před tiskem následující 

vrstvy. Je několik faktorů které je třeba vzít v úvahu pro nastavení tloušťky vrstev: 

 Požadované rozlišení – Nižší výška vrstvy bude mít za následek jemnější rastr stěn 

tištěného modelu. Faktorem pro tuto volbu je především estetika. Například 

mechanické části nepotřebují tak vysoké rozlišení, jako například model určený k 

prezentaci. 

 Rychlost tisku – Nižší výška vrstvy prodlužuje čas tisku, protože se zvýší počet 

vrstev modelu, a extruder musí každou vykreslit. Cílem je nastavit optimální 

rovnováhu mezi kvalitou tisku a časem potřebným k vytištění modelu. 

Perimeters definuje minimální počet obvodových perimetrů (stěn). Nevyžaduje li model 

přímo jediný perimetr, pak je obecně doporučováno použít alespoň 2 perimetry, protože je tím 

zajištěno částečné překrytí tiskových chyb (pokud bude chyba v jednom perimetru, druhý tuto 

chybu částečně překrývá). 

Nejvyšší a nejspodnější vrstvy, které svírají model, jsou vyplněny plným ( Solid layers ) 

vzorem. Nastavení počtu perimetrů spodní vrstvy ovlivňuje výslednou kvalitu povrchu. 

V případě chyby by byl povrch narušen, je tedy doporučeno použít alespoň dvě spodní vrstvy. 

Podobné problémy jsou i u horní vrstvy. Vzhledem k tomu, že výplň není obvykle zaplněna 

ze 100%, pak horní vrstva musí tuto výplň překrýt pomocí přemostění, toho není možno 

dosáhnout pouze jedinou vrstvou, je tedy nutné použít horních vrstev vice než jednu. 

Obrázek 15 - nedostatečný počet horních vrstev 

 

Typ: Nastavením počtu horních vrstev a výplně na 0 dokážete I z plného modelu vytisknout 

dutou nádobu. Taková úprava umožní změnu plného modelu například ve vázu. Tedy toto 

nastavení nemusí ovlivňovat pouze kvalitu povrchu modelu, ale je možné jej využít k tisku 

úplně jiných modelů. 
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Obrázek 16 - Vytvoření vázy z plného modelu 

 

Infill - výplň 

Fill density je definována rozmezím od 0 do 1 kde 1 je 100% a 0.4 znamená 40%. Ve 

většině případů je nesmyslné plnit model ze 100% plastem, bylo by to zbytečné plýtvání 

materiálem a vytištění takového modelu by trvalo příliš dlouho. Obvykle se výplň nastavuje 

na mnohem nižší hodnotu, a materiál je sevřen plně vyplněnými vrstvami ( viz. Solid 

layers výše). 

Hustota výplně nastavená na 0.4 (40%) je absolutně postačující ve většině modelů a poskytuje 

jim slušnou mechanickou odolnost. Hustota výplně 0.2 (20%) je považována za minimální 

hustotu u modelů, které mají plochou horní vrstvu. (výplň zde slouží jako podpora této 

vrstvy). 

Slic3r nabízí několik vzorů výplně, které budou podrobně popsány níže v sekci Výplňové 

vzory a hustota. Výběr Fill pattern (vzoru výplně) je závislý na druhu modelu, 

požadované pevnosti rychlosti tisku a osobní volbě. Exotičtější druhy vzoru výplně jsou pro 

tisk velmi složité a časově náročné, proto se většinou používá vzor rectilinear, line, nebo 

honeycomb. Honeycomb poskytuje největší pevnost ale je pomalejší než oba další jednoduché 

vzory (rectilinear a line). 

Support materiál - podpory 

Tisk model způsobem odspoda nahoru, stejně jako FDM, znamená, že jakékoliv výrazné 

převisy jsou tištěny do vzduchu a s největší pravděpodobností se prohnou a budou špatně 

vytištěny. Volba podpůrný materiál (Generate support material) přidá do modelu další 

strukturu, která bude podpírat převislé součásti během tisku. Volba Pattern spacing 

nastavuje vzor a hustotu podpůrného materiálu. 
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Obrázek 17 - příklad objektu tištěného s podporou (support material) 

 

Tip: Někdy je dobré zvážit orientaci modelu. (otočením modelu může dojít k minimalizaci 

potřebných podpěr, případně se veškeré převisy odstraní). 

Raft layers přidá další vrstvy pod model. Tato volba pochází z počátků 3D tisku. Může 

pomoci s tiskem bez vyhřívané podložky nebo tam, kde podložka není rovná. Obvykle není 

potřeba a nedoporučuje se – model je nutné po vytištění opracovat a tuto vrstvu odstranit. 

Speed - rychlost 

V Simple režimu je nastavení pouze rychlostí tří pracovních pohybů: 

 Perimeters – tisk vnějších vrstev modelu by měl být o něco pomalejší, aby se 

minimalizoval počet případných kazů. 

 Infill – protože výplň není vidět, může být tisk o něco rychlejší. Dávejte pozor aby 

jste nenastavili rychlost nad možnosti vaší tiskárny. Extruder by nemusel stíhat 

dodávat material tiskové hlavě, a infil by se mohl výrazně ztenčit. 

 Travel – Skok mezi koncem vytlačování a začátkem dalšího vytlačování – měl by být 

proveden tak rychle jak to jen vaše tiskárna umožní, aby se minimalizovalo množství 

samovolně vytečeného materiálu z trysky. 

Brim – okraj první vrstvy 

Brim width přidá další perimetry k první vrstvě, tím zvětší plochu povrchu, aby se model 

lépe přilepil k tiskové podložce. Tento okraj je po tisku nutné uříznout. 

Obrázek 18 - příklad použití Brim 
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Sequential Printing – postupný tisk 

Tato funkce umožňuje poskládat na tiskovou podložku vice objektů s tím, že každý je tištěn 

samostatně, poté se hlava vrátí zpět na pozici Z=0 a začne tisk dalšího modelu. Viz sekce 

Sequential Printing v pokročilém tisku.  

Filament Settings – nastavení materiálu 

Filament Settings nastavení vlastností filament – nevyužívá se často, obvykle jen při 

výměně filamentu 

Obrázek 19 - režim Simple : nastavení filamentu 

 

Filament 

Diameter průměr vlákna (filamentu) je nastaven již z průvodce, zde je možné hodnotu 

aktualizovat. 

Extrusion multiplier toto nastavení umožňuje jemné doladění průtoku tryskou. Nastavuje 

se číslem, kdy 1 znamená 100% a například 1.5 by znamenalo 150%. Hodnota by se měla 

primárně nastavovat ve firmware tiskárny. Tato volba slouží opravdu k jemnému doladění, 

proto změny provádějte po krocích o velikosti +- 0.05, protože účinky jsou okamžitě velmi 

viditelné. 

Temperature - teploty 

Tyto hodnoty jsou take předvyplněné již z průvodce, ale zde je navíc možnost změnit teploty 

pro tisk první vrstvy modelu. 

Printer Settings – nastavení tiskárny 

Karta Printer Settings bude měněna nejméně často, pokud Slic3r nebude používán pro 

vice tiskáren (například ve 3D tiskových farmách). 
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Obrázek 20 - režim Simple: Printer Settings 

 

Size and coordinates – rozměry 

Bed size velikost tiskové podložky je převzato z průvodce a používá se pouze pro náhled 

modelu v kartě plater. 

Print center je bod, kolem kterého se bude model tisknout. U podložky o rozměrech Bed 

size 200mm x 200mm a tisk nastavení hodnot Print center na 100mm x 100mm bude 

model tištěn do prostřed. Někdy je nutné tisknout I mimo střed, například protože uprostřed je 

ve skle škrábanec, pak je možné tuto volbu použít. 

Z offset se používá pro kompenzaci nesprávně z kalibrovaného Z-End stopu. Pokud se 

tryska v pozici Z=0 nachází nepatrně nad podložkou, je možné použít zápornou hodnotu a 

rozdíl srovnat. Správné řešení je ale kalibrovat end stop na tiskárně. 

Optimální pozice Z-End stopu je taková, kdy se tryska téměř dotýká tiskové podložky. Jako 

měřidlo je možné použít obyčejný list papíru. Nedoporučuje se používat toto nastavení pro k 

zvýšení přilnavosti první vrstvy k podložce. Raději se podívejte do sekce Návrhy 
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Firmware 

Vybáno již v průvodci. – definuje druh G-kódu který bude generován. 

Extruder 

Nozzle diameter - průměr trysky – nastaveno již v průvodci. 

Retraction – vytlačování materiálu 

Length - když není materiál vytlačován a má vysokou viskozitu, může vlivem gravitace 

samovolně vytékat. Aby se tomuto předešlo, můžete nastavit tuto hodnotu na nějaké kladné 

číslo reprezentující počet mm, o které se má vlákno před nepracovním pohybem zatáhnout 

zpět. Tento zpětný pohyb vlákna bude automaticky kompenzován před následujícím 

pracovním pohybem o stejnou hodnotu.  

Obvykle se doporučuje hodnota mezi 1 – 2 mm. Bovdenové extrudery ale potřebují až 4 nebo 

5mm, vzhledem k pružnosti PTFE trubičky.  

Lift Z - tento parametr akceptuje kladnou hodnotu a vyjadřuje počet mm o které se má před 

cestovním pohybem posunout osa Z nahoru. Používá se pro to, aby tryska při pohybu 

nezachytila o jakékoliv již vytištěné vlákno. Obvykle není potřeba, a zpomaluje se tisk. 

Obvykle plně postačuje hodnota 0.1mm. 

Start, End and Layer Chance G-codes – příkazy na začátku a konci souboru 

Vlastní G-kód příkaz, který může být spuštěn před začátkem tisku a po dokončení tisku. Do 

G-kód příkazů můžete vkládat různé zástupné znaky, například [next_extruder] vrátí index 

následujícího extruderu. 

Webové stránky RepRap wiki jsou dobrým zdrojem pro pochopení G-codes: 

http://reprap.org/wiki/G-code. 

Poznámka: Ujistěte se, že daný G-kód je validní pro firmware ve vaší tiskárně. 

Kód definovaný v Start G-code je vložen na začátek výstupního souboru, přímo za příkazy 

řídící teplotu tiskové hlavy a podložky. Pokud ve vašem kódu jsou příkazy ovlivňující teplotu 

(M104 nebo M190), pak tyto příkazy nahradí předchozí, zavedené z parametrů z karty 

filament settings.  

Běžné příkazy G-kódu, které se používají před zahájením tisku: 

 G28 – domovská pozice všech os. 

Běžné příkazy G-kódu, které se používají po ukončení tisku: 

 M104 S0 - nastaví teplotu extruderu na nulu. 

 M140 S0 - nastaví teplotu podložky na nulu. 

 G28 X0 – nastaví osu X na hodnotu 0. 

 M84 – uvolní motory – vypne napájení motorů.  
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EXPERT režim 

Speed 

Jakmile je tiskárna nastavena a výtisky jsou bezproblémové kvality, je možné zvýšit rychlost 

tisku. To v důsledku může znamenat nejen to, že tištěný model je rychleji hotový, ale i další 

výhody. Rychlejšího tisku lze využít k tištění v tenčích vrstvách – tedy ke zvýšení kvality 

modelu, další předností je, že rychlejší pohyb při přejezdu tiskové hlavy omezí množství 

samovolně vytékajícího materiálu. 

Nejjednodušší způsob ladění je po malých krocích zvyšovat jednotlivé parametry pohybů a 

sledovat vliv této změny na kvalitu tisku. Rychlost pojezdu nastavte jako první a od ní 

odvozujte ostatní rychlosti. Není nereálné dosáhnout až rychlosti 250 mm / s (pokud to vaše 

tiskárna zvládne). Nastavení rychlosti tisku obvodových perimetru a výplně je k dispozici již 

v základním režimu. Obecné pravidlo je, obvod tisknout o něco pomaleji než výplň, aby se 

snížila pravděpodobnost možné vady na povrchu modelu (výplň může být rychlejší, protože 

vady ve výplni nebudou viditelné). 

Expertní režim nabízí více nastavitelných parametrů pro jemné doladění rychlosti pohybů 

tiskárny. Je zde možné nastavit zvlášť rychlost tisku vnějších perimetrů, rychlost tisku malých 

a velkých perimetrů, rychlost tisku výplně, přemostění a rychlost nepracovních pohybů, dále 

je možné zvlášť nastavit rychlost tisku první vrstvy modelu. 

Obrázek 21 - režim Expert - nastavení rychlosti pohybů tiskárny 
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Hodnoty mohou být uváděny i v procentech, kdy vypočítaná hodnota je vždy odvozena od 

předchozího řádku. To znamená, že pokud nastavíte rychlost plné výplně (solid infill) na 

50% pak se plná výplň bude tisknout poloviční rychlostí než jaká je nastavena pro běžnou 

výplň (infill). 

Obecné pokyny pro jednotlivé definice: 

 Perimeters – v expertním režimu lze tento parametr mírně navýšit, protože celistvost 

poslední vnější pohledové vrstvy lze zajistit nastavením rychlosti ve volbě External 
perimeters  

 Small perimeters – určeno k nastavení rychlosti tisků drobných detail, jako jsou 

různé výstupky, díry a podobně – doporučuje se zde menší rychlost tisku. 

 External perimeters – rychlost tisku finální vnější stěny, pomalejší tisk může 

zajistit čistší a hladší povrch modelu. 

 Infill – nastavte maximální možnou rychlost, jakou vaše tiskárna zvládne, aniž by 

docházelo k výraznému trhání výplně (záleží na rychlosti extruderu - při příliš rychlém 

vytlačování materiálu, se může vlákno trhat a oslabila by se integrita výplně). 

 Solid infill – spodní vrstvy modelu a další plné vrstvy (pokud je model obsahuje) 

by se měli tisknout o něco pomaleji výplň, ale rychlost zde může být vyšší než u 

obvodových stěn. 

 Top solid infill – zadejte třeba nechat dostatek času pro vytlačování materiálu, 

aby se dobře navázal a horní vrstva se slívala do rovného povrchu. Posledních několik 

vrstev musí přemostit mezery výplně modelu a připravují podklad pro rovnou finální 

vrstvu. 

 Support material – obecně se podpory mohou tisknout tak rychle jak je to jen 

možné, protože na jejich vzhledu nezáleží. 

 Bridges – Přemostění mezi prázdnými místy modelu, příliš pomalý tisk zapříčiní 

prohýbání tisknutých vláken, naopak příliš rychlé pohyby mohou mít za následek 

trhání vláken. Zde je nutné experimentovat a hodně záleží i na chlazení. Obecně lze 

ale říci, že přemostění by se mělo tisknout pomaleji než obvodové stěny. 

 Gap fill – rychlost vyplňování malých mezer v modelu. Krátké pohyby hot-endu a 

jejich vysoká rychlost mohou zapříčinit rozkmitání celé tiskárny. Je tedy vhodné tuto 

rychlost snížit. Nastavením této hodnoty na 0, docílíte úplného zakázání tisku těchto 

drobných výplní. 

 Travel – nepracovní pohyb – tak rychlý jak vaše tiskárna zvládne, minimalizuje se 

tí,m množství samovolně vytékajícího materiálu. 

 First layer speed – rychlost tisku první vrstvy – jak již bylo zmíněno, je třeba 

první vrstvu tisknout správně, a menší rychlost zde velmi ovlivňuje míru přilnutí k 

Nastavením této hodnoty na 50%, nebo i méně může výrazně pomoci. 

Acceleration control- nastavení zrychlení při tisku obvodů, přemostění, výplní a stejně 

tak i obecné zrychlení při pohybech os tiskárny. Tyto hodnoty musí odpovídat schopnostem a 

konstrukci vaší tiskárny a je lepší je poté zadat přímo do firmware. 

Nezapomeňte vzít v úvahu I omezení, která jsou pro jednotlivé pohyby nastaveny přímo ve 

firmware vaší tiskárny. 
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Výplňové vzory a hustota  
Při výběru výplně bereme v úvahu několik faktorů: pevnost předmětu, dobu tisku, druh materiálu, 

osobní preference. Je zřejmé, že pro složitější vzor výplně bude nutné provést více pohybů tiskové 

hlavy a tedy tisk bude časově náročnější a zvýší se spotřeba materiálu. 

Obrázek 22 - Nastavení vzoru výplně 

 

Slic3r nabízí několik vzorů výplně, čtyři pravidelné a tři vice exotické vzory. Čísla v 

závorkách u každého vzoru uvádějí čas potřebný pro tisk modelu 20mm kostky s danou 

výplní a spotřebu materiálu na tento model. Poznámka: čísla jsou pouze informativní pro 
porovnání jednotlivých vzorů. V reálu záleží na mnoha dalších faktorech jako je složitost konkrétního 
tisknutého tvaru a podobně.

Obrázek 23 – výplň: Line (344.51mm / 5m:20s) 

 
 
Obrázek 24 - výplň: Rectilinear (350.57mm / 5m:23s) 

 
 
Obrázek 25 - výplň: Concentric (351.80mm / 5m:30s) 

 
 

Obrázek 26 - výplň: Honeycomb (362.73mm / 5m:39s) 

 
 
Obrázek 27 - výplň: Hilbert Curve (332.82mm / 5m:28s) 

 
 
Obrázek 28 - výplň: Archimedean Chords (333.66mm / 5m:27s) 
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Obrázek 29 - výplň: Octagram Spiral (318.63mm / 5m:15s) 

 

Různé typu výplně jsou vhodné pro různé typy modelů, pro konstrukční modely jsou určeny 

jiné výplně než pro organické modely. Na obrázku je vidět, jak výplň “honeycomb” zpevní 

strukturu mechanicky namáhaného dílu, protože jednotlivé šestistěny přesně kopírují spodní 

vrstvy. Výsledná struktura je ve vertikálním směru velmi odolná tlaku. 

Obrázek 30 -porovnání výplňových vzorů u složitějšího modelu. Z leva doprava: honeycomb, line 

 

Mnoho modelů vyžaduje výplň pouze s nízkou hustotou. Při výplni o hustotě, řekněme 50%, 

bude model velmi zhutněný, a jeho tisk spotřebuje zbytečně mnoho materiálu. Z toho důvodu 

je možné zvolit hustotu výplně okolo 10% až 30%. Je třeba vzít v úvahu, k jakému účelu bude 

model sloužit a dle toho optimalizovat hustotu výplně. Obrázek ukazuje, nastavení hustoty 

výplně ovlivní výsledný vzor. 
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Obrázek 31 - Infill patterns at varying densities. Left to Right: 20%,40%,60%,80%. Top to Bottom: Honeycomb, Concentric, 
Line, Rectilinear, Hilbert Curve, Archimedean Chords, Octagram Spiral 
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Pokročilé nastavení výplně 

Ve Slic3ru je možné nastavit další pokročilé vlastnosti výplně, čímž je možné ještě vice 

optimalizovat kvalitu tisku. 

Obrázek 32 - rozšířené nastavení tisku výplně 

 

 Infill every n layers – tiskni jen každou n-tou vrstvu – pokud je větší než 1, pak 

při tisku modelu bude specifický počet výplně vynechán. Tedy výplň bude ve 

vertikální ose řidší – zrychlí se tisk, sníží se spotřeba materiálu, ale také se sníží 

pevnost modelu. 

 Only infill where needed - Slic3r zanalyzuje model, a výplň dodá jen tam, kde je 

to třeba pro podepření převisů a stropů – zvýší rychlost tisku, ušetří materiál, ale 

oslabí model. 

 Solid infill every n layers – nastaví opakování plné výplně po určitém počtu 

vrstev – zvyšuje pevnost modelu. Nula zakazuje tisk plné výplně. 

 Fill angle – Ve výchozím nastavení je výplň tištěna pod úhlem 45° vůči modelu, 

tím se zvyšuje přilnutí výplně ke stěnám, protože výplň tištěná rovnoběžně se stěnou 

má větší tendenci se odlamovat. U některých modelů je ale výhodné úhel změnit aby 

byla struktura výplně optimalizována. 

 Solid infill threshold area – velikost prostoru, který má být vyplněn ze 100%. 

Pro zvýšení pevnosti je u malých prostor vhodnější použít plnou výplň. 

 Only retract when crossing perimeters – Zpětné zasouvání filamentu a zvedání 

tiskové hlavy pouze pokud je opuštěna hranice modelu. Zpětné popotahování a 

zvedání tiskové hlavy je nutné, pouze pokud je tryska mimo hranice modelu, protože 

uvnitř modelu případný samovolně vyteklý materiál nebude vidět. Pokud ovšem 

materiál vytéká opravdu příliš, může to způsobit různé problémy i uvnitř modelu. 

Nicméně moderní tiskárny tímto problémem příliš netrpí. 

 Infill before perimeters - Obrátí pořadí, ve kterém je vrstva tištěna. Obvykle se 

obvod vrstvy tiskne jako první a až po té se tiskne výplň, což je výhodné, protože 

obvod pak působí jako stěna, obsahující výplň. 

Boj se samovolným vytékáním materiálu 

V okamžiku, kdy není materiál vytlačován, má stejně velmi vysokou viskozitu, takže se může 

stát, že samovolně vytéká z trysky. Je zde několik nastavení, která by tomu měla předejít. 

Tato nastaveni nazývejme „odjíždení“ (Retraction). 
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Nastavení odjíždení naleznete v kartě Printer tab, je zde možné nastavit zpětné 

popotahování filament z hot-endu před každým nepracovním (cestovním) pohybem tiskové 

hlavy, tím klesne tlak ve vytlačovací trysce, což by mělo vézt ke snížení samovolného 

vytékání materiálu. Toto popotažení filamentu je před následným pracovním pohybem opět 

kompenzováno o stejnou délku filamentu. 

Obrázek 33 - nastavení tzv. odjíždění 

 

 Length – počet mm, o které se má filament vrátit. Všimněte si, že délka je se zadává v 

mm, o které se má posunout surový materiál, tedy filament přímo v extruderu. Obecně 

se doporučuje nastavit posun o 1-2 mm, což by mělo stačit. U bovdenových extruderů 

bude možná potřeba nastavit hodnotu až 4 nebo 5mm, kvůli pružnosti PTFE trubičky. 

 Lift Z – zvednutí celé tiskové hlavy o definovaný počet mm po ose Z při cestovním 

pohybu. Tím lze zabránit tomu, aby tryska narazila do již položeného vlákna v rámci 

cestovních pohybů. Zvedání osy Z je obecně pomalé, a tak se prodlužuje celková doba 

tisku. Doporučuje se nastavit velmi malou hodnotu, ve většině případů bude stačit 0.1 

mm. 

 Speed – rychlost jako se bude filament zatahovat, měla by být nastavena na maximální 

možnou hodnotu, kterou extruder ještě zvládne bez přeskakování kroků (zde je dobré 

experimentovat) aby byla reakce co nerychlejší. 

 Extra length on restart – přidání dalších několika mm filamentu, po každém 

cestovním pohybu. Toto použijte v případě, že při tisku vykazuje tryska známky 

nedostatku materiálu po cestovních pohybech (přidávejte opatrně po malých částech). 

 Minimum travel after retraction – zatahovat filament při velmi krátkých 

cestovních pohybech je zbytečné, protože množství materiálu, který při nich vyteče je 

minimální, a výrazně by se zpomaloval tisk. Zde je možné nastavit minimální délku 

cestovního pohybu, před kterou se má zatažení filamentu provádět. Pokud tiskárna 

výrazně netrpí na samovolné vytékání materiálu, je možné tuto hodnotu nastavit až na 

5-6mm. 

 Retract on layer change – zatažení filament i při pohybu po ose Z – změně 

vrstvy. Opět pomáhá při problémech se samovolným vytékáním a zabraňuje tvorbě 

kuliček na povrchu modelu. Doporučuje se ponechat zapnuté. 

 Wipe before retract – otření trysky při zatahování filament – tisková hlava se v 

rámci výplně modelu posune během zatahování filament, tím dojde k otření trysky a 

tím se sníží pravděpodobnost vytvoření kuličky na povrchu modelu. 

Dále je ve Slic3ru několik dalších nastavení v záložce Print, které pomáhají při řešení 

problémů se samovolným vytékáním. 
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 Only retract when crossing perimeters (položka Infill) – říká Slic3ru, že má 

provádět odjíždění pouze v případě, že tisková hlava opouští hranice tištěné vrstvy. Je 

vhodné ponechat zapnuté, protože samovolně vyteklý materiál uvnitř výplně není 

vidět a jeho male množstvý je zde přijatelné. 

 Avoid crossing perimeters (položka Layers and perimeters – skupina 

Quality) – Nutí tiskovou hlavu maximálně sledovat obvodové stěny a pokud možno 

je nekřížit. Toto nastavení samozřejmě ovlivňuje počet a délku pohybů, tedy I velikost 

souboru s G-kódem a samozřejmě dobu tisku. 
 Seam position (položka Layers and perimeters – skupina Advanced) – toto 

nastavení ovlivňuje polohu počátečního a koncového bodu obvodového perimetru a tím tedy 
I polohu potencionálně viditelného švu na bočních stěnách tištěného modelu. Je možné 
vybrat z následujících možností::  

o Random – náhodná – tato volba znamená, že se pro každou vrstvu tento bod vybere 
náhodně, po každé jinde, šev se tedy rozloží a není tolik viditelný. 

o Nearest – nejbližší – snaží se najít nejbližší vydutou plochu bez vrcholu, aby byl šev 
skrytý uvnitř konkávního úhlu, pokud taková není k dispozici, hledá nejbližší 
vypouklou plochu bez přesahu vrcholu. Pokud není k dispozici, vybere jakýkoliv bod 
mimo vrchol. Vždy se vybírá bod, který je nejblíže k aktuální pozici trysky. Tím se 
optimalizují pohyby a zkracuje se doba tisku. 

o Aligned – pro nalezení optimálního švu se použije stejná logika jako u volby 
Nearest, ale s tím, že se použije ten bod, který je nejblíže k počátečnímu bodu 
předchozí vrstvy, tím se docílí toho, že šev je na většině modelů zarovnán v celém 
objektu. 

Další způsoby pro zajištění toho, aby se mezi objekty netvořily spoje, naleznete také v části 

Sekvenční Tisk. 

Skirt and brim - ohraničení a okraj první vrstvy 

Skirt - ohraničení 

Pomocí nastavení Skirt můžete přidat kousek od hranice modelu tenkou stopu, která 

pomáhá naplnit hot-end a trysku materiálem, ještě než se začne tisknout samotný model. 

Obrázek 34 - nastavení Skirt - ohraničení 

 

 Loops – počet cyklů, které se mají kolem modelu vytisknout, než začne tisk 

samotného modelu – obvykle stačí jeden. 

 Distance from object – vzdálenost ohraničení od samotného tištěného modelu. 

Výchozí nastavení je 6mm, což je obvykle dostačující. 

 Skirt height – Počet vrstev ohraničení, které se mají vytisknout. Plynulý proud 

materiálu je zajištěn vždy už první vrstvou, ale této funkce lze využít, pokud chcete 

tištěný model chránit například před průvanem – kolem modelu se vytvoří stěna. 
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 Minimum extrusion length – minimální délka extruze nastaví počet milimetru, 

materiálu, které musí tryska minimálně vytlačit, než se začne samotný model tisknout. 

Použije se v okamžiku, kdy by samotné ohraničení nemělo požadovanou délku. 

Brim – okraj první vrstvy 

Brim width – šířka okraje první vrstvy – okraj první vrstvy se používá ke zvětšení povrchu 

první vrstvy a zvětšuje přilnavost modelu k podložce. Tento okraj je nutné, po dokončení 

tisku a odlepení modelu od podložky, odříznout. 

Obrázek 35 - příklad Brim - okraje první vrstvy 

 

Cooling 

Teplota hraje klíčovou roli pro kvalitu tisku. Pokud je teplota příliš vysoká, materiál se 

deformuje, pokud je příliš nízká, jednotlivé vrstvy se nemusí dobře slepit. Chlazení modelu se 

uplatní především při tisku drobných detailů, převisů a přemostění, kdy je třeba, aby materiál 

chladl rychle a poskytoval pevný základ pro další vrstvy. 

Existují dva způsoby chlazení: chlazení ventilátorem a snížení rychlosti tisku. Slic3r 

umožňuje využití obou technik současně. Materiál je ochlazován ventilátorem a zároveň, 

v případě, že vrstva je vytištěna rychle, může tisk zpomalit. 
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Obrázek 36 - ukázka strategie chlazení Slic3ru 

 

Na obrázku vidíte techniku chlazení, kterou využívá Slic3r. Když je potřeba ochlazovat tisk ochlazovat zvýší se otáčky 
ventilátoru. V místě, kde otáčky ventilátoru již dosáhnou maximální rychlosti, a je třeba chladit stále intenzivněji, je 
snižována rychlost tisku dokud nedosáhne minimální hodnoty. 

Ventilátory 

Většina elektronik a firmware dnes umožňuje přidání ventilátorů pro chlazení. Ty pak mohou 

být řízeny příkazy G-kódu, Tedy Slic3r je schopen generovat takový kód kterým je lze zapínat 

a vypínat a měnit rychlost jejich otáček. 

Ventilátor by měl být umístěn tak, aby neochlazoval tiskovou podložku více než je nezbytně 

nutné. Stejně tak by neměl ochlazovat topný blok hot-endu, aby jej nebylo potřeba více 

dohřívat a plýtvat tak energií. Proud vzduchu by měl být usměrněn především na hrot trysky, 

ze které vytéká čerstvý materiál. 

K tomu se využívá nástavec na ventilátor, který pak vzduch přivádí přesně tam kde je potřeba. 

Různé modely těchto nástavců pro různé typy tiskáren naleznete online. 

Zpomalení tisku 

Slic3r umí tisk zpomalit, pokud odhadovaná doba tisku konkrétní vrstvy je pod určitou 

hranicí. 

Účinek tohoto zásahu může byt ale ovlivněn tím, jak daleko se tryska pohybuje od již 

vytištěných vrstev, to může být problém malých detailních částí, kdy samotná tryska znovu 

ohřívá prostor okolo sebe a nedojde ke správnému chladnutí. Z toho důvodu se doporučuje, 

pokud je to možné, používat ventilátor. 
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Nastavení chlazení 
Obrázek 37 - nastavení chlazení modelu 

 

 Keep fan always on – drž ventilátor vždy zapnutý – pokud je zaškrtnuto, ventilátor 

se nikdy nevypne a jeho chod bude udržován alespoň na minimálních otáčkách. 

Výhodné pro tisk z PLA ale špatné při tisku z ABS. 

 Enable auto cooling – zapíná a vypíná automatickou logiku chlazení. Podrobnosti 

jsou popsány v textu přímo pod volbou: 

Jestliže předpokládaný čas tisku vrstvy je nižší než 5 sekund, poběží ventilátor na 100% a rychlost tisku 
bude se sníží tak, aby tisk této vrstvy netrval kratší dobu než 5s (rychlost tisku ale nikdy neklesne pod 
10 mm / s) 
Jestliže předpokládaný čas vrstva je delší, ale stále nedosahuje 60s, poběží ventilátor rychlostí mezi 
100% a 35% přímo úměrně odhadované době tisku vrstvy. 
V ostatních vrstev, bude ventilátor se vypne. 

 Fan speed - Určuje minimální a maximální rychlost otáček ventilátoru. Užitečné pro 

ventilátory, které se ve výchozím nastavení otáčejí příliš rychle. 

 Bridges fan speed – rychlost otáček ventilátoru při tisku přemostění – je potřebné 

chladit co nejvíce, je tedy doporučeno nastavit maximální otáčky. 

 Disable fan for first n layers – v kapitole jak je důležitá první vrstva je 

detailně popsáno proč prbvní vrstvu nechladit, proto zde můžete nastavit počet vrstev, 

při jejiž tisku má být ventilator vypnutý – doporučuje se alespoň 2-3 vrstvy. 

 Enable fan if print time is below t seconds – zapni ventilátor, pokud bude 

tisk vrstvy pod t sekund - Aktivuje ventilátor v případě, že vrstva bude dokončena pod 

stanovený počet sekund. 

 Slow down if layer print time is below t seconds – zpomalí tisk, pokud je 

předpokládaná doba tisku vrstvy pod t sekund. 

 Min print speed – Minimální povolená rychlost tisku. 

 

Support Material 

Obecně platí, že většina 3D tiskáren umí tisknout modely s převislými částmi ale jen do určité 

míry. Úhel převisu, který je ještě tisknutelný, závisí na několika faktorech, nejvíce rozhoduje 
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výška vrstvy a šířky extruze a obvykle se pohybuje kolem 45 °. U modelů s většími přesahy 

musí být model doplněn o nosnou konstrukci (podporu). To zapříčiní větší spotřebu materiálu 

a prodlouží se doba tisku. 

Obrázek 38 - nastavení pro tisk podpor 

 

První věc, kterou musíte udělat, je aktivovat podpory zaškrtnutím políčka Generate support 

material. Vyplněním hodnoty 0 do pole  Overhang threshold docílíte toho, že Slic3r najde 

všechna místa, která potřebují podporu automaticky, v ostatních případech hodnota definuje 

hraniční úhel, který již podporu vyžaduje. Generování podpor je celkem složité a proto se 

doporučuje nastavit všude prahové hodnoty na 0, a umožnit Slic3ru vygenerovat podpory 

automaticky. 

Malé modely, a modely s malou základnou, se někdy mohou utrhnout během tisku od 

podložky. Proto i pro ně je vhodné podpory vygenerovat v určitém počtu vrstev k zajištění 

jejich stability během tisku a to bez ohledu na úroveň prahového úhlu převisu. 

Pro ukázku tiskových vzorů podpor byl zvolen model hrnečku a byl nakloněn o 45° podél osy 

X tak jak je vidět na obrázku. 

Obrázek 39 - model hrnku nakloněný o 45° 

 

Stejně jako u tisku výplně, i pro podpory existuje několik vzorů: 
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Obrázek 40 - výplň podpory: Rectilinear 

 

Obrázek 41 - výplň podpory: Rectilinear Grid 

 
 

Obrázek 42 - výplň podpory: Honeycomb 

 

Pattern Spacing určuje vzdálenost mezi jednotlivými linkami vzoru podpory – něco 

podobného jako hustota výplně jen se zde zadává přímo v mm. Pokud měníte, berte v úvahu 

šíři tištěné linky a množství spotřebovaného materiálu pro podpůrnou konstrukci. 

Při výběru tiskového vzoru podpor berte ohled i na to jaký tvar model má, a snažte se vybrat 

takový vzor, který bude liniemi navazovat na model kolmo, aby bylo možné podpory později 

snadno odstranit. Pokud by to nebylo možné docílit s výchozím nastavení, je možné pomocí 

volby Pattern Angle úhel vzoru podpory nastavit - otočit.. 

Obrázek 43 - příklad vzoru podpory otočeného o 45° 
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Šíře extruze 
Obrázek 44 - nastavení šířky vytlačovaného vlákna 

 

Jeden z důvodů pro změnu šířky extruze již byl zmíněn: šíře extruze první vrstvy by měla 

činit dvounásobek její výšky, aby se zlepšila přilnavost k podložce. Existují ale i další 

případy, kdy je modifikace šířky extruze užitečná. 

 Perimeter – tenčí vnější perimetr zajistí, že výsledný model bude mít ve výsledku 

přesnější povrch. 

 Infill and Solid Infill – širší extruze při tisku výplně urychlí tisk a struktura 

modelu bude pevnější. 

 Top infill – tenčí extruze při tisku horní finální vrstvy bude mít ve výsledku lepší 

kvalitu povrchu a všechny rohy budou dobře vyplněny. 

 Support material – Stejně jako u tisku výplně, i zde silnější extruze urychlí tisk a 

zvýší pevnost podpor. 

Je důležité si pamatovat, že pokud je šířka extruze zadána v procentech, pak je dopočítána z 

hodnoty Layer height a ne z hodnoty Default extrusion width. 

Postupný tisk 

Při tisku několika objektů najednou je dobré, aby se samostatně tisknul každý z nich, protože 

to bude minimalizovat samovolné vytékání a mezi jednotlivými modely se minimalizuje počet 

vláken přetažených tryskou. Také se sníží riziko, že se zničí celý výtisk v případě, kdy se 

například jeden model odloupne od podložky nebo jinak zdeformuje. 

Obrázek 45 - nastavení postupného tisku 
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Je třeba zajistit, aby se tryska nebo extruder nedostali do kontaktu s již vytištěnou částí jiného 

modelu na podložce. Slic3r by měl upozornit, pokud by hrozila kolize mezi modelem a 

tiskovou hlavou ale raději dvakrát zkontrolujte, zda uspořádání modelů na podložce 

nezpůsobí problémy. Parametr Extruder clearance v záložce Print Settings -> 

Output Option pomáhá Slic3ru hledat případné kolize: 

 Radius – vůle, která by měla být okolo tiskové hlavy – pokud není tryska montována 

uprostřed, pak volte maximální bezpečnou vzdálenost. 

 Height – svislá vzdálenost mezi špičkou trysky a tyčí osy X, případně jiným 

nejnižším bodem, který by mohl zasahovat do hotového výtisku. 

Obrázek 46 - volný prostor kolem válce hotendu 
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Variabilní výška vrstvy 

Slic3r umožňuje nastavit výšku vrstvy v libovolných polohách na ose Z.. To znamená, že část 

modelu může být vytištěna s větší výškou vrstvy, například vertikální řezy a ostatní části 

mohou být vytištěny jemnějšími vrstvami, například tam kde jsou v modelu šikmé přechody, 

tedy v místech kde se výška vrstvy projeví nejvíce.  

Obrázek 47 - příklad modelu, na kterém bude zvýrazněna přednost variability výšky vrstev 

 

Model zobrazený na následujícím obrázku je typickým příkladem, kde by mohly být použity 

variabilní výšky vrstev pro zlepšení kvality tisku. Stěny konstrukce nemusí být tištěny ve 

vysokém rozlišení i tak bude dosaženo přijatelné kvality tisky, avšak šikmá střecha již 

vykazuje známky tisku ve výšce vrstvy 0,4 mm, je příliš hrubý, zejména poslední vrstva je 

velmi zploštělá.  

Obrázek 48 - příklad rozložení vrstev v normálním režimu 

 

Nastavení variabilních vrstev je dostupné z okna Plater, po té co dvojklikem kliknete na 

název modelu nebo samotný model. Otevře se pop-up okno, které obsahuje dvě záložky. 

První záložka Info obsahuje obecné informace o modelu, jak vidíte na obrázku. 
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Obrázek 49 - informace o tiskovém modelu – záložka info 

 

Zde stojí za zmínku především výška modelu, která se nám bude hodit při výpočtu maximální 

výšky Z. 

Druhá záložka (viz obr.) obsahuje tabulku, kde každý řádek definuje výšku vrstvy pro určitý 

rozsah podél osy Z (rozměry jsou v mm). Na obrázku vidíme, že stěny modelu jsou vytištěné 

na výšku vrstvy 0.4 mm, strmější část modelu je tištěna na výšku vrstvy 0.2 mm horní část 

modelu na 0,15 mm. Všimněte si, že každá řada navazuje přesně na předchozí, a výška části 

je dělitelná výškou vrstvy bezezbytku – mezi jednotlivými řádky nesmí existovat žádné 

mezery. 

Obrázek 50 - nastavení variabilní výšky vrstev 

 

Výsledný G-Code (viz obr.) vygenerovaný dle předchozí tabulky vykazuje podstatně větší 

přesnost a měl by vést k vyšší kvalitě tisku. 
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Obrázek 51 - stejný model s variabilním nastavením vrstev 

 

Obrázek ukazuje porovnání skutečně vytištěných modelů, vlevo s pevnou výškou vrstvy 

0.4mm a vpravo s variabilní výškou vrstvy. 

Obrázek 52 - ukázka výtisku s variabilní výškou vrstvy 

 

An additional feature of the variable layers height option is that by entering a zero for a range 

that part of the model will not be printed. Fig. shows the G-Code where layers between 0 and 

4mm are skipped. This is a useful way of dividing a tall model into multiple, shorter sections 

which can be printed individually and assembled afterwards. 

Další možností variabilních výšek vrstvy je, že pokud zadáte nulovou výšku vrstvy pro 

definovaný rozsah modelu, tento rozsah nebude vytištěn vůbec. Na obrázku vidíte stejný 

model, kde jsou vynechány vrstvy mezi 0 a 4 mm. Toho lze využít například pro snadné 

řezání vysokých modelů do kratších úseků, které můžete sestavit později. 

Obrázek 53 - příklad s vynechanými vrstvami 
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Struktura konfigurace 

Profily 

Konfigurace je ve Slic3ru rozdělena do tří kategorií: 

 Printer Settings: zde jsou definovány vlastnosti tiskárny. Změny v této skupině se 

dělají pouze při změně tiskárny, tedy obvykle pouze při počáteční konfiguraci nové 

tiskárny. 

 Filament Settings: v této skupině jsou definice tykající se vlastností tiskového 

materiálu (filamentu) jako je průměr vlákna, teploty podložky a hot-endu, a chlazení 

modelu. 

 Print Settings: Nastavení vlastního jednotlivého tisku, změny se zde 

předpokládají s každým dalším tiskem a mění se s ohledem na požadovanou kvalitu a 

rychlost, ale i například pokud chcete měnit vlastnosti samotného modelu. 

V hlavním okně Plater můžete snadno a rychle vybírat vaše uložené profily, které chcete pro 

konkrétní tisk použít. Vždy volíte všechny tři kategorie, tedy Printer, Filament a Print. 

Vytvoření profilu 

Otevřete požadovanou kartu a změňte nastavení podle potřeby. Jakmile budete spokojeni, 

klikněte na ikonu uložit na levé straně nad seznamem podkategorií. Do pop-up okna zadejte 

vhodný název profilu. 

Obrázek 54 - uložení profilu 

 

Pokud s profilem nejste spokojení, můžete jej libovolně znovu editovat a kliknutím na ikonu 

uložit opět změny do profilu přidávat.  

Pokud profil chcete odstranit, klikněte na červenou ikonu vedle ikony uložit. Profil bude 

nevratně odstraněn. 
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Obrázek 55 - mazání profilu 

 

Export a import profilů 

Chcete-li přenést nastavení do jiného počítače, odeslat jej e-mailem nebo jej uložit ke svému 

modelu, můžete použít export konfigurace (File -> Export Config). Tím dojde k vytvoření 

INI souboru obsahujícího veškeré vámi nastavené předvolby. Takový soubor lze později 

velmi snadno znovu načíst pomocí příkazu File -> Load Config. 

Načtení konfigurace nepřednastaví tuto konfiguraci do seznamu uložených profilů, a Slic3r si 

ji při dalším spuštění nebude pamatovat. Pokud chcete načtené profily uložit do Slic3ru, pak 

musíte projít všechny záložky Print Settings, Filament Settings a Printer Settings 

a v každé kliknout na ikonu uložit. 

Položka File -> Export Config Bundle... umožňuje exportovat kompletní sadu profilů do 

jediného souboru (ne jen vybrané profily). To je praktické hlavně když chcete přenést 

nastavení Slic3ru z jednoho počítače do druhého, nebo v případě, když chcete vytvořit zálohu 

nastavení Slic3ru. 

Nastavení vlastního pracovního adresáře 

Ve výchozím nastavení Slic3r ukládá svá nastavení do systémového adresáře, který je závislý 

na druhu a verzi operačního systému vašeho počítače. Uživatele by aplikace neměla nijak 

obtěžovat s vybíráním pracovních adresářů, proto se tedy vybírá automaticky. Nicméně, 

Slic3r umožňuje uživateli pomocí příkazu –datadir zadaného do příkazové řádky vybrat 

vlastní pracovní adresář. To se může hodit v případě, že potřebujete držet více kopií Slic3ru 

na jednom počítači, nebo třeba pokud chcete sdílet nastavení po počítačové síti. 

Sdílení nastavení a profilů v počítačové síti 

Pokud máte k počítači připojen síťový disk, pak můžete konfiguraci sdílet na tomto disku. 

Jednoduše spustíte Slic3r z příkazového řádku zadáním například tohoto příkazu: 

slic3r.exe --datadir Z:\Slic3r-settings 

Na operačních systémech Linux a MacOS X jsou i další možnosti kromě příkazu –datadir. 

Můžete třeba vytvořit odkaz z místa, kam si Slic3r ukládá svá nastavení do svého sdíleného 

adresáře, což lze využít třeba k ukládání těchto nastavení na Dropbox. Prvním krokem je tedy 

zjistit, kam si Slic3r nastavení ukládá a tedy kde je při spuštění hledá: 
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$ /Applications/Slic3r.app/Contents/MacOS/slic3r --debug 

wxWidgets version wxWidgets 2.9.4, Wx version 0.9922 

Data directory: /Users/al/Library/Application Support/Slic3r 

Nyní, po té co Slic3r ukončíme, můžeme přesunout nalezený adresář do standardně sdílené 

složky: 

mv "/Users/al/Library/Application Support/Slic3r" ~/Dropbox/Slic3r-settings 

(Uvozovky jsou nutné, protože v cestě adresáře je mezera, nicméně pokud tohle děláte, jistě 

umíte pracovat v příkazovém řádku :-) 

A nakonec vytvoříme symbolický odkaz zpět: 

ln -s ~/Dropbox/Slic3r-settings "/Users/al/Library/Application 

Support/Slic3r"  
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Opravy modelů 

Pokud 3D model obsahuje chyby, jako jsou chybějící stěny, případně jsou hrany neuzavřené, 

pak některé z těchto chyb Slic3r umí opravit sám. Ovšem některé chyby v STL souborech 

jsou nad jeho možnosti, Pokud tedy Slic3r stále hlásí problém s modelem, a nebo jej chybně 

rozvrství, pak je čas zkusit nějaký další způsob opravy modelu. 

Netfabb Studio 

Netfabb nabízí velké množství různých aplikací pro modelování 3D objektů, včetně základní 

verze kterou dává volně k dispozici. Tato verze obsahuje nástroj pro opravu sítě uzlů modelu, 

a dokáže nalézt a opravit velké množství různých chyb. Aktuální, podrobné pokyny pro práci 

s tímto nástrojem najdete na Netfabb wiki, tedy následující pokyny jen přiblíží základní kroky 

vedoucí k opravě modelu. 

Obrázek 56 - NetFabb Studio - oprava modelu 

 

 Spusťte Netfabb Studio, a otevřete problematický STL soubor, a to buď přes menu 

File, nebo přetažením ji na pracovní plochu. Pokud Netfabb zjistí nějaký problém 

ukáže červené výstražné znamení v pravém dolním rohu. 

 Pro spuštění opravného skriptu, vyberte díl modelu a klikněte na ikonu první pomoc 

(first aid – červený kříž), případně jej můžete spustit přes menu Extras->Repair 

Part. Tím se otevře záložka oprav, která zobrazí stav modelu. 

 Záložky Actions a Repair scripts nabízejí několik variant skriptů oprav, které 

můžete aplikovat ručně, nicméně v rámci zjednodušení tohoto přehledu bude stačit 

pokud vyberete automatické opravy, což vyřeší většinu problémů. 

 Tlačítko automatické opravy nabídne na výběr dvě možnosti: Výchozí (default) a 

jednoduchou (simple) opravu. Vyberte výchozí, ta vyřeší většinu problémů. Tímto 

výběrem spustíte skript pro opravu. 

 Jakmile je díl opraven, musíte rozhodnout, zda provedenou opravu aplikovat do 

modelu, Volbou Apply repair (použít opravu) rozhodnete, zda se má dotčený díl v 

modelu přepsat či ne. 

http://www.netfabb.com/basic.php
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 Opravený díl pak můžete vyexportovat pomocí položky Export part->As STL v 

kontextovém menu. 

 Pokud Netfabb zjistí další chybu, kterou daný díl obsahuje, pak na ní znovu upozorní a 

nabídne další opravné skripty před exportem. 

Obrázek 57 - NetFabb Studio: export části modelu 

 

Netfabb Cloud Service 

Netfabb take poskytuje webovou službu, kam je možné STL soubor nahrát, zkontrolovat a 

případně opravit. 

Obrázek 58 - NetFabb Cloud Services 

 

 Přejděte na adresu http://cloud.netfabb.com 

 Vyberte a nahrajte problémový STL soubor. 

 Aby jste se dozvěděli, že je soubor zpracovaný, musíte zadat svou E-mailovou adresu 

 Zvolte, zda mají být použity metrické nebo imperiální jednotky. 

 Měli by jste si přečíst podmínky služby a souhlasit s nimi, potom klikněte na tlačítko 

Upload to Cloud. 

 Jakmile služba soubor zanalyzuje a opraví, pak vám zašle na zadaný email link na 

stažení opraveného souboru 

http://cloud.netfabb.com/
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FreeCAD 

Freecad je komplexní  CAD program, je volně dostupný a take obsahuje siťový modul, který 

umí analyzovat a opravovat STL modely. Následující popis vám v několika krocích popíše 

jak to udělat. 

Obrázek 59 - FreeCad – oprava modelu 

 

 Spusťte FreeCAD a na úvodním rozdělovníku vyberte Working with Meshes. 

 Vložte problematický přetažením na plochu, případně pomocí File menu. Malá 

zpráva v levém dolním rohu vám prozradí, zda má model nějaká problematická místa. 

 V menu zvolte Meshes->Analyze->Evaluate & Repair mesh, tím se otevřete 

dialogové okno s volbami oprav. 

 Z dialogové nabídky vyberte nahraný díl, po té proveďte analýzu každého druhu 

problému kliknutím na tlačítko Analyze, nebo vyberte ve spodu Repetitive Repair 

pro spuštění všech kontrol. Pokud je nalezen příslušný problém, aktivuje se příslušné 

tlačítko Repair. 

 Pro každou požadovanou opravu stiskněte tlačítko Repair. 

 Je důležité si vždy zkontrolovat provedenou opravu, protože se může stat, že opravný 

script smaže některý trojúhelník, který je potřeba, a model by se spíše poškodil, než 

opravil. 

 Exportujte opravený díl pomocí položky Export v kontextovém menu. 
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SVG výstup 

Slic3r umí generovat výstup I pro některé další typy 3D tiskáren, které potřebují mít na vstupu 

každou vrstvu reprezentovanou SVG souborem, jako jsou například DLP pryskyřicové, nebo 

práškové tiskárny. Tyto tiskárny obvykle očekávají, že obrázek bude bílý na černém pozadí 

(viz. obrázek níže). Lze použít téměř všechny formáty obrázkových souborů (například bmp, 

png, atd), nicméně protože se obrázek obvykle zmenšuje nebo zvětšuje, je výhodné používat 

vektorový formát místo bitmapy. Slic3r tedy používá jako výstupní formát soubor typu 

Scalable Vector Graphics (SVG). 

Obrázek 60 - příklad vrstvy ve formátu SVG 

 

Slic3r je tedy schopný produkovat SVG výstup, použitelný pro tyto tiskárny, Namísto použití 

Plater okna, ale proces začíná výběrem volby menu File -> Slice to SVG... . Otevře se 

dialogové okno pro výběr vstupního souboru (STL, OBJ nebo AMF). Po té se ihned otevře 

dialogové okno pro nastavení, kam má být uložen výstupní soubor typu SVG. Nyní Slic3r 

Vygeneruje a uloží soubor SVG. 

Pokud se pokusíte SVG soubor otevřít například v prohlížeči, zobrazí se pouze první vrstva a 

v ní jen otvory, protože pozadí prohlížeče je obvykle bílé. 

Obrázek 61 - SVG soubor zobrazený v prohlížeči 

 

Z toho důvodu byla napsána malá webová aplikace, která je schopná zobrazovat jednotlivé 

vrstvy souboru na černém pozadí. Aplikaci najdete na tomto odkazu a vygenerovaný SVG 

soubor do ní stačí přetáhnout. 

http://garyhodgson.github.io/slic3rsvgviewer/
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Obrázek 62 - prohližeč SVG souborů 

 

Nastavení SVG výstupu 

Většina možností v Slic3r není při generování SVG potřebná, avšak nastavení výšky vrstvy 

bude určovat výsledný počet vrstev. Všimněte si, že Slic3r omezuje výšku vrstvy tak, aby 

byla menší, než je průměr trysky, takže možná bude nutné zvětšit průměr trysky, pokud 

vyžadujete větší výšku vrstvy. 

Tisk SVG souboru 

SVG výstup může být použit v celé řadě tiskáren. Následující příklad ukazuje, jak může být 

soubor použit v pryskyřicové DLP tiskárně. S použití upravené verze Klimenta Printrun může 

být soubor SVG načten přímo a poslán do DLP projektoru. Osa Z se ovládají pomocí příkazů 

G-kód zasílaných přes printcore komponenty, což znamená, že může být použita standardní 

RepRap elektronika, jako je například RAMPS. 

Obrázek 63 - Tisk SVG výstupu z ProjectLayeru 
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Tisk s více Extrudery 

Tiskárna s více než jedním extruderem může být použita různými způsoby. Pokud máte 

model složen z více částí, které definují různé oblasti, můžete přiřadit každé z nich jiný 

extrudér. Pokud máte jednodílný model, můžete přiřadit různé role každému extrudéru: 

například, pro tisk výplní můžete použít větší trysku, nebo můžete tisknout podpory 

z rozpustného materiálu. 

Nastavení extruderů 

V okně Printer Settings naleznete nastavení jednotlivých extruderů. Ve výchozím 

nastavení je dostupná konfigurace pouze pro jeden extruder, nicméně v obecných volbách 

(záložka General) ve skupině Capabilities, můžete nastavit jejich počet ve volbě 

Extruders. Zvýšením této hodnoty se okamžitě přidá v levém sloupci záložek odpovídající 

počet extruderů. 

Obrázek 64 - nastavení tisku s více extrudery - nový extruder se přidá ihned do levé části okna 

 

Každý extruder se definuje stejně jako první, nicméně je zde potřeba nastavit další parametry, 

které se týkají pouze přidávaných extruderů. 

Obrázek 65 - nastavení pro 2. a další extruder 
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Volbu Extruder offset použijte v případě, že váš firmware neřeší vzdálenost jednotlivých 

trysek od sebe (offset). Více informací se dozvíte nahlédnutím do dokumentace k vašemu 

firmware. Každý další přidaný extruder by měl mít nastavenou pozici trysky vůči prvnímu 

extruderu, který má offset obvykle na souřadnicích 0,0. Pokud firmware ve vaší tiskárně již 

offset řeší, pak ve Slic3ru nastavte všechny offsety na 0,0. 

Protože pracuje vždy jen jeden extruder, pak je potřeba materiál zasunout u nečinných 

extruderů zpět, stejně jako u běžného jedno-extruderového tisku, při cestovních pohybech, 

aby nedocházelo k samovolnému vytékání materiálu. A stejně tak se i v tomto případě délka 

vlákna, o kterou bude posunuto zpět, zadává v mm surového vstupního materiálu. 

Nástroj pro změnu extruderu 

Blok Custom G-code v okně Printer Settings umožňuje přidat vlastní příkazy G-code, 

které se provedou při požadavku na změnu extruderu během tisku. Stejně jako v ostatních 

řčástech kde je možné použít vlastní G-code, tak i tady je možné použít zástupné znaky 

odkazující na některé hodnoty tisku. Jako příklad uveďme proměnné [previous_extruder] 

a [next_extruder]. 

Obrázek 66 - při použití více extruderů, je možné vložit vlastní G-code  

 

Přiřazení vlastností tiskového materiálu konkrétnímu extruderu 

Pokud jste vybrali tisk s vice extrudery, pak ve výchozím okně Plater můžete každému 

extruderu přiřadit druh materiálu. 

Obrázek 67 - více-extruderový tisk -výběr materiálu 
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Přiřazení extruderů pro jedno-materiálový model 

Pro modely, které mají být tištěny z jednoho materiálu, je možné také využít více extruderů. 

Přiřazení jednotlivých extruderů pro specifické části modelu (perimetry, výplň, podpory) se 

nastavuje v okně Print Settings v záložce Multiple Extruders. 

Obrázek 68 – více-extruderový tisk - nastavení tisku 

 

Tisk více-materiálových modelů 

Pokud už máte k dispozici více-materiálový tiskový podklad (AMF soubor) protože vámi 

používaný CAD software jej umí vytvořit sám, pak jej můžete otevřít ve Slic3ru běžným 

postupem stejně jako soubor STL. Přiřazení extruderů k jednotlivým částem modelu proběhne 

popořadě, tedy první část se bude tisknout extruderem č.1, druhá extruderem č.2 atd. 

Vytvoření více-materiálového tiskového podkladu (soubor AMF) 

Slic3r umí kombinovat STL soubory mezi sebou a vytvářet tak více-materiálové tisky AMF. 

 Rozdělte ve vašem CAD program model po jednotlivých materiálech a vyexportujte 

každou část zvlášť jako STL soubor. 

 Ve Slic3ru, vyberte položku menu File -> Combine multi-material STL 
files... 

 Až se zobrazí dialogové okno pro výběr souboru, vyberte první část vašeho modelu, 

k té bude přiřazen extruder č.1, klikněte na tlačítko Open (otevřít) a budete vyzvání 

k výběru další části modelu, a postup opakujte. Pokud máte vybrány již všechny části 

modelu, klikněte na tlačítko Cancel. 

 Následující dialogové okno vás vyzve k uložení vytvořeného více-materiálového 

tiskového podkladu do souboru AMF. 

Po uložení souboru jej lze načíst a tisknout tak jak již bylo popsáno výše. 
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Vzorkové výtisky 

Pokud chcete pouze otestovat model v reálném světě a nezáleží vám na kvalitě tisku ani, 

můžete změnit pár nastavení tak, aby bylo generování G-code a tisk co nejrychlejší. 

Print Settings > Layers and perimeters > Quality 
 

Obrázek 69 - nastavení kvality tisku 

 

Tyto volby zajištují hezčí a čistší tisk modelů, nicméně jejich výpočet je náročný na výkon 

procesoru a prodlužuje i dobu tisku. Pro návrh G-code a následný tisk testovacích vzorků 

nejsou tyto volby důležité. 

 Extra perimeters if needed: Tato funkce kontroluje, zda se mají přidávat další 

obvodové vrstvy na šikmých plochách, které pomáhají skrývat vnitřní výplň, aby tak 

byl objekt hezčí. 

 Avoid crossing perimeters: Tato funkce sleduje pohyby tiskové hlavy a snaží se 

minimalizovat případy, kdy dochází k pohybu trysky přes obvodové stěny. Tím se 

zabraňuje tomu, aby na stěnách modelu ulpíval samovolně vytečený materiál. 

Nicméně výpočet trasování cest tiskové hlavy se provádí pro každou vrstvu zvlášť, 

což je velmi náročné na procesorový čas, pokud teprve rozmisťujete model na 

podložce, nebo nepotřebujete mít model ve vysoké kvalitě, pak tuto volbu vypněte. 

 Detect thin walls: Tato funkce se snaží detekovat místa, kde jsou obvodové stěny 

příliš tenké – především u malých perimetrů, a nenutí pak tiskárny takto tenké steny 

vytlačovat, naopak použije průměr jejich osy a materiál přidá – opět náročné na 

výpočet a u modelů, kde nezáleží na kvalitě zbytečné. 

 Detect bridging perimeters: Detekuje místa, kde tisk musí přemostit prázdná 

místa, přičemž pro tato místa se upravuje chlazení a rychlost tisku – stejně jako 

v předchozích případech náročné na výpočet. 

Print Settings > Infill 

Vzory výplní Hilbert Curve, Archimedean Chords a Octagram Spiral jsou obecně hodně 

pomalé jak na tisk, tak na generování G-code. Je dobré se těmto výplním při tisku, kde 

nezáleží na kvalitě, vyhnout, obzvláště pokud chcete zkrátit čas přípravy. 

Print Settings > Advanced > Resolution 

Ve výchozím nastavení Slic3r nezjednodušuje geometrii modelu a snaží se všechny detaily 

nějak převézt do výstupního G-code. Mnohdy ale takto přesný model ani sama tiskárna není 

schopna vytisknout v tak vysokém rozlišení, takže je vhodné hned výchozí podklad modelu 
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zjednodušit, obzvláště v případě kdy kvalita tisku není rozhodujícím parametrem. Toho lze 

dosáhnout nastavením rozlišení na hodnotu kolem 0,05 nebo dokonce až 0,1. 

Print settings > Advanced > Threads 

(Tento bod platí pro všechny druhy tisku, nejen pro tisk s nízkou kvalitou) Mnoho vnitřních 

algoritmů ve Slic3ru podporuje zpracování v paralelních vláknech. Tedy je dobré Slic3ru 

umožnit zpracování v tolika vláknech kolik procesorových jader je ve vašem počítači.  
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Využití příkazové řádky 

Téměř všechny funkce Slic3ru jsou dostupné z příkazové řádky. To lze využít pro volání 

Slic3ru z různých skriptů nebo když chcete instalovat Slic3r na server bez periférií. 

Chcete-li získat úplný seznam všech příkazů, které jsou z příkazové řádky dostupné, pak stačí 

spustit: 

slic3r --help 

Poznámka: možná bude třeba změnit text slic3r jménem nebo celou cestou k spustitelnému 

souboru Slic3ru, na jednotlivých systémech to může být: 

 slic3r-console.exe na systému Windows 

 slic3r na systémech GNU/Linux 

 Slic3r.app/Contents/MacOS/slic3r na systémech MacOS X 

 perl slic3r.pl na všech platformách, pokud spouštíte Slic3er z Git/zdrojového 

kódu 

generování G-code 

Pro rozřezání modelu do G-code stačí dát Slic3ru jako parametr patřičný model a jakoukoliv 

konfiguraci kterou chcete použít: 

slic3r my_model.stl --layer-height 0.2 

Takto se vygeneruje soubor pojmenovaný my_model.gcode který bude ve stejném adresáři 

jako vstupní STL soubor. Můžete ale výstupní soubor umístit kamkoliv a pojmenovat jej 

libovolně: 

slic3r my_model.stl --layer-height 0.2 --output /path/to/output.gcode 

Argumentem pro --output může být také pouze adresář, v tom případě se soubor pojmenuje 

automaticky dle nastaveného schématu (které lze změnit pomocí příkazu --output-

filename-format). 

Options 

Chcete-li získat úplný seznam všech příkazů, parametrů a přepínačů, které jsou z příkazové 

řádky dostupné, pak stačí spustit: 

slic3r --help 

Mnoho přepínačů akceptuje hodnotu jako parametr, například --layer-height 0.2 nebo --

perimeters 3. Existuje ale i řada přepínačů, typu boolean které parametr nepotřebují, 

například: --wipe nebo --avoid-crossing-perimeters. Pokud chcete tyto volby negovat, 

pak stačí před přepínač přidat prefix --no- (jako například: --no-wipe nebo --no-avoid-

crossing-perimeters). 



   Slic3r manuál

 54 

 

Některé přepínače, včetně těch, které se týkají více-extruderového tisku, přijímají I více 

parametrů. Stačí je tedy připojit vícekrát: 

slic3r --infill-extruder 2 --nozzle-diameter 0.35 --nozzle-diameter 0.5 

Načtení konfigurace 

Poznámka: všechna nastavení v kartách print/filament/printer která jsou přednastavena v 

grafickém režimu, jsou při spuštění příkazu v příkazové řádce úplně ignorovány. Slic3r tedy 

v příkazové řádce vždy vychází z výchozího nastavení. 

Pokud chcete vaše nastavení z grafického režimu použít, pak jej musíte vyexportovat pomocí 

položky menu File -> Export Config. Tím vytvoříte INI soubor, který můžete z příkazové 

řádky načíst: 

slic3r my_model.stl --load my_config.ini 

Přednastavené volby v INI souboru můžete přepsat připojením jejich přepínače: 

slic3r my_model.stl --load my_config.ini --fill-pattern concentric 

Můžete také vytvořit samotný konfigurační soubor INI přímo z příkazového řádku: 

slic3r --nozzle-diameter 0.35 --filament-diameter 2.85 \ 

    --temperature 185 --first-layer-temperature 195 --layer-height 0.2 \ 

    --save my_config.ini 

Pokud patříte mezi pokročilejší uživatele, pak můžete rozdělit konfiguraci do více INI 

souborů a ty pak připojovat postupně pomocí --load přepínače. 

Další možností, jak používat předvolby na kartách print/filament/printer je spouštět grafické 

rozhraní Slic3ru s přepínačem –-autosave: 

slic3r --autosave my_config.ini 

Tím docílíte toho, že veškeré změny, které provedete v grafickém rozhraní, se vždy uloží do 

zadaného INI souboru a tedy budete mít vždy k dispozici poslední konfiguraci, kterou jste 

použili, tu můžete opět připojit v příkazové řádce pomocí přepínače --load. 

Zpracování více vstupních souborů najednou 

Pokud Slic3ru předáte více vstupních souborů najednou, pak je Slic3r zpracuje postupně a pro 

každý z ních vygeneruje patřičný G-code 

slic3r model1.stl model2.stl model3.stl 

příkaz výše vygeneruje soubory: model1.gcode, model2.gcode, model3.gcode. 

Chcete-li zpracovat více souborů a vložit je do jedné tiskové úlohy, pak můžete použít 

přepínač –-merge (nebo -m): 

slic3r -m model1.stl model2.stl model3.stl 
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Tento příkaz pak vygeneruje pouze jeden soubor model1.gcode obsahující všechny tři modely 

(samozřejmě můžete použít volbu  --output popisovanou výše, a upravit jméno výstupního 

souboru). Poznámka: modely se automaticky rozmisťují na podložce, což funguje nejlépe, 

pokud jsou všechny modely přibližně stejně veliké. 

Umisťování modelů na souřadnice v G-code 

Vstupní soubor(nebo soubory) budou umístěny kolem bodu definovaného přepínačem --

print-center: 

slic3r my_model.stl --print-center 40,40 

Ve výchozím nastavení je tento bod na souřadnicích 100,100. 

Opravování chyb modelu 

Slic3ru můžete využít i k opravě chyb ve vašem modelu z příkazového řádku: 

slic3r --repair my_model.stl 

Tento příkaz vygeneruje soubor s názvem my_model_fixed.obj který bude uložen do stejného 

adresáře jako je vstupní soubor. Tento výstupní soubor už není editovatelný, stejně jako 

výstupní formát OBJ, který je upřednostňována před STL, liší se ale tím, že na rozdíl od STL 

formátu, OBJ formát nepovoluje numerické chyby a odchylky. Většina 3D aplikací a i Slic3r 

je ale schopen tyto soubory číst. 

k získání informací o souboru lze použít přepínač --info: 

slic3r --info cube.stl 

Info about cube.stl: 

  size:              x=20.000 y=20.000 z=20.000 

  number of facets:  12 

  number of shells:  1 

  volume:            8000 

  needed repair:     no 

Řezání modelů 

Slic3ru můžete využít také k řezání vašeho modelu z příkazového řádku: 

slic3r --cut 10.2 my_model.stl 

Tento příkaz vygeneruje dva soubory ve stejném adresáři, kde byl vstupní soubor. Soubory 

budou pojmenované my_model_lower.stl a my_model_upper.stl . 

Poznámka: Model bude automaticky umístěn do roviny z = 0 před řezáním, tedy argument 

pro přepínač --cut je vztažen k dolní části objektu, nikoliv k původnímu systému souřadnic. 
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Vkládání Slic3ru do dalších aplikací 

Následující přepínače jsou užitečné zejména, pokud chcete Slic3r využít jako součást jiných 

aplikací: 

 --no-plater spustí Slic3r jen v režimu konfigurace, tím předejdete zmatku v případě, 

že hostitelská aplikace disponuje vlastním zobrazením modelu; 

 --autosave bude automaticky exportovat naposledy zvolené konfigurace do souboru 

(viz výše uvedený odstavec o konfiguraci); 

 --gui-mode může přebírat parametr simple nebo expert a spustí Slic3r v příslušném 

režimu, s tím že ignoruje poslední nastavení volby režimu. 

 --datadir za kterým následuje cesta ke zvolenému adresáři, nastaví Slic3ru místo, 

odkud si má načítat a kam má ukládat své nastavení (Více informací v kapitole 

„Nastavení vlastního pracovního adresáře“) 
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Post-Processing skripty 

Mohou nastat situace, kdy je potřeba Slic3rem již vygenerovaný G-kód vylepšit nebo změnit. 

Z tohoto důvodu je zde možnost spustit libovolný skript jako součást závěrečných kroků v 

procesu generování. 

Příklady takových skriptů můžete najít v GitHub repository nebo na RepRap forum. 

Note: post-processing script mohou být psané v jakémkoli programovacím jazyce (Perl, 

Python, Ruby, Bash a podobně.). Pouze musí být spustitelné a jako parametr akceptovat cestu 

k souboru s vygenerovaným G-code 

V sekci Print Settings -> Output options najdete volbu Post-processing scripts. 

Tam zadejte absolutní cesty ke každému skriptu oddělené od sebe středníkem. Všechny 

skripty musí být na vašem operačním systému spustitelné. 

Obrázek 70 - přidání post-processing skriptů 

 

Každému skriptu bude předána absolutní cestu k souboru G-kódu, který Slic3r vygeneruje. 

Skript musí G-code upravit v in-place režimu, případně může nový výstup uložit do 

temporary souboru a tím pak přepsat původní. 

Všechny volby nastavení Slic3ru, se kterými je G-code generován, jsou skriptům volně 

dostupné, a všechny začínají řetězcem SLIC3R_, například: SLIC3R_LAYER_HEIGHT. 

Následující skript G-code nemění, pouze vypíše veškerá nastavení Slic3ru na standardní 

výstup: 

#!/bin/sh 

echo "Post-processing G-code file: $*" 

env | grep ^SLIC3R 

Z bezpečnostních důvodů nelze skriptům předávat další argumenty, nicméně stačí napsat 

skriptu obálku. 

Perl example 

In-place režim Perlu (perl -i) usnadňuje upravit obsah G-code souboru, aniž by bylo nutné jej 

kopírovat, upravovat a pak nahradit původní. Následující příklad jednoduše vypíše obsah G-

code souboru na standardní výstup: 

#!/usr/bin/perl -i 

use strict; 

use warnings; 

 

while (<>) { 

https://github.com/alexrj/Slic3r/tree/master/utils/post-processing
http://forums.reprap.org/list.php?263
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     # modify $_ here before printing 

     print; 

} 

Pokud se vám vrátí chyba can't do inplace edit without backup při zpracování post-process 

skriptu, zkuste přidat $^I = '.bak'; před while cyklus. Tím se vytvoří záložní soubor s 

vygenerovaným G-code. Systém Windows nemá rád, když dva programy sahají na stejný 

soubor současně, takže zde je záloha nutná. 
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Flow Math 

Tato stránka vysvětluje matematický model, používaný ve Slic3ru, k určení množství 

vytlačovaného materiálu. Dokumentace je nabídnuta jako referenční podklad pro připomínky 

a požadavky které by mohly vézt k pokusu o navržení lepšího modelu. 

Pojem: „šířka extruze“ 

Dvě hlavní otázky, které ovlivňují funkci Slic3ru: 

1. Jak daleko od sebe by měly být extrudované cesty, aby se docílilo pěkně souvislého povrchu? 
2. Kolik materiálu se musí vytlačit na tyto cesty? 

Pokud jsou dvě sousední cesty příliš blízko u sebe, nebo pokud do nich bude vytlačeno příliš 

mnoho matriálu, pak se budou překrývat. Naopak pokud budou cesty příliš daleko od sebe, 

nebo do nich bude vtlačeno příliš málo materiálu, pak mezi nimi budou viditelné mezery a 

může dojít i k jejich rozpojení, protože se špatně slepí. 

Změnou vytlačovaného množství materiálu nebo změnou rychlosti pohybu trysky, 

můžeme ovlivnit šířku vytlačované cesty. 

Obrázek 71 - šířka vytlačované cesty 

 

Silnější cesty se budou lépe spojovat s předchozí vrstvou, čímž docílíme lepších 

mechanických vlastností, ale zase model nebude rozměrově tak přesný, zaplní se malé mezery 

a úzké křivky.(bude potřeba vrtat díry pro šroubky, nebude možné zasouvat do úzkých míst 

potřebné součástky a podobně). Naopak tenké cesty se hůře spojí s podkladem, ale zase 

dosáhneme větší rozměrové přesnosti. 

Nicméně berte na vědomí, že šířka cesty je ovlivnitelná pouze na existujícím podkladu, 

(předchozí vrstva, nebo podložka). Pokud tisknete do vzduchu (například při tisku 

přemostění), výsledný tvar vlákna bude vždy kulatý, a bude odpovídat průměru trysky: 

Obrázek 72 - tvar vlákna při tisku přemostění 
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Ve skutečnosti, pokud snížíte při tisku do vzduchu průtok materiálu, pak budou vlákna sice 

stále kulatá ale tenčí., což jde jen do určité míry, kterou ovlivňuje viskozita materiálu, po té 

dojde k přetržení vláken a přemostění se zbortí. Pokud naopak materiál přidáme, tvar vlákna 

se nezmění (stále bude odpovídat tvaru trysky), ale vlákna budou prověšená. 

Takže začněme od definice: 

 

Přemostění: jednoduchý případ 

Jak již bylo vysvětleno výše, při tisku do vzduchu je jen jeden správný průtok materiálu. 

Takový, při kterém se vlákna neprověšují, ale ani netrhají. Vlákna jsou kulatá a odpovídají 

průměru trysky. Vzdálenost mezi jednotlivými drahami je nastavena tak, aby se vlákna jen 

dotýkala a nebyly mezi nimi mezery, tedy odpovídá přesně průměru trysky.(u tisku 

přemostění se vlákna nesmí překrývat, protože je prokázáno, že se pak popotahují) 

Množství materiálu na délkovou jednotku je tedy odvozeno od kruhového tvaru a rozměru 

trysky: 

E = (nozzle_diameter/2)^2 * PI 

Extruze na pevnou podložku 

V tomto případě nastává otázka: jaký tvar bude mít výsledná cesta? Víme, že výsledný tvar 

bude horizontálně rozmáčknutý, ale bude mít tvar obdélníku nebo bude oválný? Jaké 

maximální šířky dráhy je možné docílit z konkrétního průměru trysky, než se plast začne po 

stranách ohýbat nahoru? 

Slic3r předpokládá, že tvar příčného řezu vytlačované dráhy je obdélníkový s půlkruhovými 

konci. Takže vztah mezi požadovanou šířkou vytlačování a objemem materiálu je následující: 

Obrázek 73 - poměr materiálu a šíře dráhy 

 

Šířka Extruze je tloušťka jednoho vytlačovaného vlákna a to buď do 

volného prostoru, nebo nad podložkou. Není to tedy jen vzdálenost dvou 

sousedních drah, protože obecně se aplikuje vždy částečné překrytí těchto drah 

tak, aby se docílilo lepšího spojení vláken. 
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Když je šířka vytlačované dráhy menší než výška vrstvy, tvar vlákna je nepředvídatelný takže 

se používá pouze vzorec pro obdélníkový tvar. Ale důrazně se nedoporučuje používat tohoto 

poměru při extruzi. 

Výše uvedená formulace poskytuje funkci, která v závislosti na šíři vytlačování a výškou 

vrstvy definuje požadované množství materiálu na jednotku délky: 

E = f(extrusion_width, layer_height) 

Rozteč drah 

Dobře, teď víme, kolik materiálu vytlačovat, abychom vytvořili jednu dráhu o požadované 

šíři. Ale o kolik bychom měli dráhy překrývat, abychom docílili dokonalého propojení? 

Předpokládejme, že se dráhy nepřekrývají, tedy se pouze dotýkají na tečnách, a tudíž je mezi 

nimi prázdný prostor (žlutá): 

Obrázek 74 - nepřekrývající se vlákna 

 

Spočítáme tedy průměr prázdné plochy řezu: 

void_area = layer_height^2 - (layer_height/2)^2 * PI 

Ideálně bychom rádi zaplnit všechno prázdné (žluté) místo a vrstvu tak dokonale uzavřely, 

nicméně je velmi nepravěpodobné že druhá extruze vyplní celý postor který vznikl během 

předchozí, takže stejně nějaké prázdné místo zůstane. Tedy výsledné překrytí lze vyjádřit 

nějak takto: 

0 < overlap_factor*void_area < void_area 

Když bude overlap_factor někde mezi 0 – 1, pak reprezentuje, kolik % zůstane 

nevyplněno. Je velmi těžko toto číslo určit a v minulosti se experimentovalo s různými 

hodnotami, a nejspíše hodně záleží na vlastnostech plastu a jeho viskozitě, nicméně někteří 

uživatelé si stále stěžovali, že tisk je velmi řídký. Nyní je overlap_factor nastaven na 1, 

tedy chyba se přesunula spíše do oblasti, že materiálu je více než je potřeba, tedy nestane se, 

že by materiálu bylo málo. 

Rozteč cesta je tedy: 

spacing = extrusion_width - layer_height * (1 - PI/4) 

Rozumné výchozí nastavení 

Slic3r dovoluje uživateli definovat šířku vytlačování manuálně, zvlášť pro každý typ extruze, 

(obvodové stěny, výplň, podpory atd.), ale pokud nejsou tyto hodnoty zadány, pak ve 

výchozím nastavení jsou zadány rozumné průměry. 



   Slic3r manuál

 62 

 

Pro poslední vnější dráhu ve vrstvě, (external perimeters) má Slic3r ve výchozím nastavení 

velmi tenkou šířku extruze, která se rovná průměr_trysky * 1.05. To je považováno za 

nejmenší bezpečnou šířku extruze. Tato tenká vnější dráha poskytuje modelu větší přesnost a 

minimalizuje chyby průtoku způsobené nepravidelností průměru surového vlákna. 

Šířka extruze pro ostatní tisk se počítá z průřezu trysky (za použití definovaného průměru 

trysky) a množství dodávaného materiálu na požadovanou délku pohybu trysky. Jinými slovy, 

šířka extruze je definována rychlostí pohybu trysky a průtokem materiálu tryskou. 

Smyslem je najít takový maximální průtok, který minimalizuje boční zvlnění. Takto 

vypočtená hodnota je omezena na maximální hodnotu definovanou vztahem průměr_trysky 

*1.7, s výjimkou tisku výplně, kde je použito maximální množství materiálu. 
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Prostorové chyby v tisku 

Pokud nejste spokojeni s rozměrovou přesností vašich modelů, pak se nejprve ujistěte, že 

máte správně nastaveno vše ve firmware vaší tiskárny. Jedná se především o konfiguraci 

počtu kroků/mm u krokových motorů zajišťujících pohyby os X,Y a Z. Tyto hodnoty musí 

být správně nastaveny, dle rozměrů kladek časovacích řemenů, a závitových(trapézových) 

tyčí. Nekalibrujte tyto hodnoty metodou pokus – omyl, protože tyto hodnoty by měli bát 

naprosto přesné. Případně použijte kalkulačku od Josefa Průši (Calculator). 

Chyby ve svislé ose 

Pokud je chyba v rozměru modelu ve vertikálním směru,(to jest ve směru osy Z) a váš 

vytištěný model je nižší než by měl být (což je nejčastější případ), pak to obvykle znamená, 

že tryska je příliš nízko a první vrstva je velmi stlačená na podložce. Tento problém 

odstraníte tím, že posunete nahoru end-stop osy Z, nebo nastavíte větší hodnotu pro Z offset 

ve Slic3ru. 

Chyby ve vodorovné ose 

Nejčastějším problémem je, že jsou na výtisku malé otvory. To může být způsobeno mnoha 

různými důvody. Proberme je tedy jeden po druhém:   

Tepelná roztažnost plastu  

Každý plastový materiál se při ochlazení smršťuje. Každý druh plastu má jinou tepelnou 

roztažnost, která může být navíc závislá na teplotě tisku. Tedy obvod každého kruhového 

otvoru nebo polygony, tištěného extruderem se během ochlazování zmenšuje, čímž se zmenší 

i výsledný průměr otvoru. 

Příliš materiálu uvnitř kruhu 

Když se vytlačuje vlákno po kruhové dráze pak se vloží více materiálu na délkovou jednotku 

na vnitřní straně takové dráhy, což znamená, že průměr otvoru se zmenší. Toto ve Slic3ru 

řešil kompenzační algoritmus (compensation algorithm), který navrhl Adrian Bowyer, ale 

mnoho uživatelů si stěžovalo, že otvory jsou pak příliš velké, proto byl tento algoritmus 

odstraněn, jelikož menší otvor je lepší než větší, protože jej lze opravit vrtáním. 

Kruhové tvary jsou zjednodušeny do polygonů 

Model v STL souboru je složen jen z malých trojúhelníkových ploch, tedy veškeré křivky 

musí být rozloženy do polygonů. Například kruhový otvor je reprezentován jako polygon o n 

vrcholech, viz obrázek: 

http://calculator.josefprusa.cz/
http://reprap.org/wiki/ArcCompensation
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Obrázek 75 - kruhový otvor je rozdělen do polygonu 

 

Zvětšením počtu vrcholů polygonu ve vašem CAD programu, ještě před exportem objektu 

do STL souboru, můžete výrazně zvýšit přesnost. Uživatelé, kteří používají OpenSCAD, 

mohou použít funkci polyhole() vyvinutou nophead, která dopočítává optimální počet 

vrcholů těchto polygonů. 

Tištěné vlákno se přes rohy napíná 

Vzhledem k tomu že jsou křivky zjednodušeny do polygonů, mají spousty vrcholů. Při jejich 

tisku a následném smršťování tištěného vlákna, má plast tendenci se přes rohy napínat, 

čímž opět dochází ke zmenšení vnitřního průměru všech otvorů v modelu. 

Zvlnění stěn ve vertikálním směru – Z wobble 

V případě, že rozměr jednotlivé vrstvy je naprosto přesný, ale jednotlivé vrstvy na sebe nejsou 

přesně naskládány, opět dochází k tomu, že otvor se jeví jako malý. Nepřesnému, ale 

pravidelnému poskládání vrstev se říká Z-wobble a tento jev je způsoben mechanickou 

chybou v ose Z.: 

Obrázek 76 - nepřesné poskládání vrstev v ose Z  (Z-Wobble) 

 

Nepravidelnost v šířce vlákna 

Nekvalitní a středně kvalitní tiskové materiály nemají vždy přesný průřez v celé své délce. 

Pokud budete měřit jejich průměr na jednom metru délky, naměříte mnoho různých hodnot. 

Navíc některé tyto materiály nemají ani přesně kruhový průřez. Tyto rozdíly průřezu 

materiálu způsobují nepravidelnosti v šířce extruze v jednotlivých částech modelu a 

vrstvách, čímž opět dochází ke zmenšení vnitřních průměrů otvorů v modelu:  
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Obrázek 77 - chyba způsobená nekvalitním tiskovým materiálem 

 

Vůle 

Vůle je mechanickou poruchou jedné nebo více os. Při změně směru chodu motoru, se osa 

chvíli nepohybuje, nebo nereaguje okamžitě. Vůle je způsobena volnými řemeny 

pohánějícími osy. Obvykle, u tiskáren s pohyblivým stolkem se tento problém týká osy Y, 

protože jsou zde výrazné setrvačné síly. Tedy pokud možno zkontrolujte napnutí všech 

řemenů os X aY, a pokud je potřeba, napněte je. Neexistuje žádný způsob, jak tento 

mechanický problém řešit softwarově. 

Flow math 

Dobrá, všechny výše zmíněné chyby nejsou způsobeny Slic3rem, tedy musí být odstraněny 

dříve, než začnete dělat jakékoliv softwarové úpravy. 

To znamená, že matematický model extruze ve Slic3ru je důležitý pro tisk modelů ve 

správných rozměrech, protože se snaží spočítat množství vytlačovaného materiálu, tedy šířky 

vytlačovaného vlákna s ohledem na prostorové umístěná v dané vrstvě modelu. Jakékoliv 

odhadování zde ale vede k chybám. Běžně se uživatelé snaží ladit tisk nastavením hodnoty 

Extrusion Multiplier, což sníží/zvýší množství plastu během extruze, což ale ovlivňuje i 

pevnost a povrch modelu, tedy to není ideální řešení.  

Pro větší přesnost tisku prvně zkontrolujte nastavení External Perimeters First, protože 

pokud jsou vnější stěny tištěny jako první, pak se zabrání deformacím na vnějších stěnách 

způsobených překrýváním vytlačovaných vláken. Na druhou stranu, pokud jsou vnitřní stěny 

tištěny jako první, pak se lépe schovají švy na stěnách modelu. Záleží tedy na vás, zda 

upřednostníte přesnost před vizuální stránkou modelu. 

Nově je možné nastavit také volbu XY Size Compensation, která umožňuje proporcionální 

kompenzaci rozměrů modelu v rovině horizontálního řezu. Předpokládejme, že otvory ve 

vašem objektu jsou po vytištění menší o 0.1mm, pak zadejte do této volby hodnotu -0.05 

(záporné číslo znamená, že se objekt smrští dovnitř). 

Z Wobble 

Pravidelné zvlnění ve stěnách objektu je většinou způsobeno kolísáním osy Z. Podrobnou 

analýzu tohoto problému najdete v článku "Taxonomy of Z axis artifacts in extrusion-based 

3d printing" od whosawhatsis. Nicméně jedna z obvyklých příčin kolísání osy Z je, že kroky 

krokových motorů neodpovídají stoupání závitových tyčí. Tento problém lze řešit nastavením 

výšky vrstvy na násobek celého kroku krokového motoru.

http://goo.gl/iOYoK
http://goo.gl/iOYoK
https://plus.google.com/u/0/+Whosawhatsis
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